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 Welcome...
Welcome...

Welcome to the user's guide for the desk phones Mitel 6863 SIP and 
Mitel 6865 SIP for MiVoice Office 400 communication systems.

This user's guide will assist you with the use of your phone and introduce 
you step by step to the functions and configuration. If you require further 
technical support or information on other Mitel products, please refer to our 
webpages www.mitel.com or our Mitel DocFinder.

This user's guide is relevant only for Mitel SIP phones connected to a 
MiVoice Office 400 communication system. Other user’s guides are availa-
ble for operation on other communication systems or for direct operation 
via a SIP provider. Consult your system administrator if you are unsure 
whether you have the correct user’s guide for your requirements.

Notes: • Not all listed functions are available by default. Contact your system 
administrator to learn more about the available features and services in 
the MiVoice Office 400 communication system.

• Your system administrator has the option to individually set some of the 
phone's features. In this case your default values will differ from the 
default values described in this user's guide.

• Some functions are offered both from the MiVoice Office 400 communi-
cation system and locally from your Mitel SIP phone. Since the MiVoice 
Office 400 communication system does not completely support the 
local functions we recommend making your system administrator do the 
configuration or using the Self Service Portal (see chapter "MiVoice 
Office 400 Self Service Portal", Seite 8).
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 Welcome...
Safety information
Failure to observe this information can be hazardous and infringe existing 
laws.

Connections
Always plug the phone cable connectors into the appropriate sockets. Do not 
modify the connections in any way.

Power supply
Your phone can be supplied with power in various ways. Pay attention to the 
information given by the system administrator. 

Note: The device will be inoperable when mains power of the communication system 
fails.

Metal objects
Telephone receivers produce magnetic fields that can attract small metallic 
objects such as pins and staples. To avoid injury, do not place the handset 
where such objects can be picked up.

Maintenance
Make sure all installation and repair work is carried out by a specially qualified 
technician.
Always use a soft, moistened, or antistatic cloth to clean your device. Do not use 
chemicals or other chemical products.

Cost control and Data protection
You should protect your phone with a PIN so that no-one can make phone calls 
at your expense. A code will also protect your personal settings.

Ambient conditions
Do not operate the device outside the temperature range of +5 °C to approx. 
+40 °C. Avoid direct sunlight and other sources of heat. Protect your device 
against the wet, excessive dust, corrosive liquids and steam.
Do not expose your device to electromagnetic fields (electric motors, household 
appliances). The speech quality could be affected.

Disposal
Be sure to dispose of your device, batteries and its packaging in an environmen-
tally compatible way. Electrical equipment does not belong in domestic waste. 
Deposit it at a return centre.

Accessories
Use original accessories or specifically approved accessories only. The use of 
other accessories may decrease performance or pose a risk to your health or 
safety.

1
205
Mitel 6863 SIP / Mitel 6865 SIP 3
eud-1663/1.0 – R4.0 – 06.2015



 Welcome...
Document information

Document designation
• Document number: eud-1663
• Document version: 1.0

• Based on MiVoice Office 400 R4.0
• Valid as of MiVoice Office 400 R4.0
• In PDF Viewer, click on this link to download the latest version of this 

document:
https://pbxweb.aastra.com/doc_finder/DocFinder/eud-1663_en.pdf?get&DNR=eud-1663

• Copyright © 06.2015 Mitel Networks Corporation
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 Information as to the MiVoice Office 400 communication system
Information as to the MiVoice 
Office 400 communication system

One number user concept
Your system administrator can set up several phones for you that hold all 
the same phone number (one number user concept). You have only one 
name and phone number with which to identify yourself to your call part-
ners, regardless of which of the phone you make your calls. The advan-
tage is that you can always be reached under the same phone number, 
regardless of where you happen to be.

With personal call routing you can define where incoming calls shall be 
routed to (see chapter "Activating personal call routing", Seite 45).

More benefits of the one number user concept

• You can determine the phone on which a call is  acoustically signalled, 
with Ring Alone (see "Activating ring alone", Seite 47).

• Your system administrator can set whether or not you are busy for fur-
ther incoming calls (busy if busy).

• You are still able to make further outgoing calls with the other terminals.
• Call lists and contacts stored on the MiVoice Office 400 communication 

system are available on all your phones and are automatically synchro-
nised.

• An announcement will be indicated on all phones which support 
announcements.

• Fast take (*88) allows you to take a call from one phone on another.
Mitel 6863 SIP / Mitel 6865 SIP 7
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 Information as to the MiVoice Office 400 communication system
MiVoice Office 400 Self Service Portal
The Self Service Portal is a web-based application for phones on a  
MiVoice Office 400 communication system. The Self Service Portal helps 
you configure and adapt your personal phone settings (i.e. key configura-
tion, labels for configurable keys, display language, etc.) directly and 
autonomously on your PC.

As soon as you receive an user account for the Self Service Portal from 
your assistant manager and after you have logged in, you are taken to the 
home page with the overview of all your phones. Refer to the Self Service 
Portal online help for further information on a specific topic.

Contact your system administrator to access to the Self Service Portal.
8 Mitel 6863 SIP / Mitel 6865 SIP
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Keys, display and menu guid-
ance

The sections below provide an overview and usage on 
which keys and sockets are available on your phone.

Key designations and sockets . . . . . . . . . . . . . . . . . . . . . 10

Display symbols. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Operating your phone . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Using expansion key modules. . . . . . . . . . . . . . . . . . . . . 20

Using labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
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Key designations and sockets

Mitel 6863 SIP
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P3
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11
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20

1
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Mitel 6865 SIP
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No. Key Description

1 Handset
2 Labels Labels for configurable keys

3 Message LED Colour and status signal a specific event.

4 P1-P3 function keys 
(Mitel 6863 SIP)

Freely configurable keys. Preconfigured as:
• System menu
• Redial list
• Call transfer

Function keys P1 to P8 
with LED 
(Mitel 6865 SIP)

8 free configurable keys (some preconfigured). 
An LED is located next to each function key sig-
nalling the functional state. The keys have a dual 
assignment.

5 Display Monochrome screen

6 Navigation key with 
selection key

• Navigating through the menu
• Switching line
• Confirming menu selection

7 Deflect key
(Mitel 6865 SIP only)

Transferring a call

8 Conference key
(Mitel 6865 SIP only)

Setting up conference calls

9 Call lists key
(Mitel 6865 SIP only)

Calling up the call list menu:
• unanswered
• answered
• Redial list

10 Redial key 
(Mitel 6865 SIP only)

Using the phone number last dialled

11 Line keys L1 to L2 with 
LED

Mitel 6863 SIP: 2 line keys
Mitel 6865 SIP: 2 line keys. A total of 9 lines are 
available.
• Seizing a line
• Answering a call
• Brokering with simultaneous configuration of 

multiple line keys

12 Loudspeaker key with 
LED (Mitel 6863 SIP)

• Activating/deactivating open listening
• Activating/deactivating handset microphone
12 Mitel 6863 SIP / Mitel 6865 SIP
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Loudspeaker/headset 
key with LED 
(Mitel 6865 SIP)

• Activating/deactivating open listening
• Activating/deactivating handset microphone
• Activating/deactivating headset microphone

13 Hash key Entering # or special characters

14 Digit keys 1-9 Entering characters and digits

15 Asterisk key Entering * or space

16 Microphone key with 
LED

• Activating/deactivating hands-free mode
• Activating/deactivating handset microphone
• Activating/deactivating headset microphone 

(Mitel 6865 SIP only)

17 Volume keys Adjusting volume

18 Option key Calling up a local setting menu (options list)

19 Hold key • Holding an active call
• Taking back a call from hold

20 End key • Ending a call
• Back to display in idle state
• Exiting editor without changes

21 Speaker
22 Rear (Mitel 6863 SIP):

• 100BaseT dual connection for PC and LAN
• Connection for power supply
• Connection for headset
• Connection for Power-over-Ethernet
• Connection for wall mounting

23 Rear (Mitel 6865 SIP):
• Connection for expansion key module
• Connection for power supply
• Combined four-pin module connection with DHSG headset connection1)

• GigE dual connection for PC and LAN
• Connection for headset
• Connection for Power-over-Ethernet, class 2
• Connection for wall mounting

1) Use the headset connection for headsets only. Connecting another device may cause dam-
age to your phone and void your warranty.

No. Key Description
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 Keys, display and menu guidance
Note: The Mitel 6867 SIP and Mitel 6869 SIP phones have removable key caps. 
If you change the position of a function on your phone, you can change the 
function to the corresponding function key using the Self Service Portal. 
An overview of the interchangeable functions can be found in the chapter 
"Available keys", page 80.

Display symbols

Call connection states, info

• Context-dependent softkey
• Scrolling back through the menu
• Navigate cursor
• Switching line

• Context-dependent softkey
• Goes forward one step in the menu
• Navigate cursor
• Confirming menu selection
• Switching line

• Context-dependent softkey
• Navigating through the menu
• Navigating to display in idle state

• Context-dependent softkey
• Navigating through the menu
• Confirming menu selection
• Navigating to display in idle state

Incoming call

Connected

New voice message

Activated setting

Mitel Hi-Q™ audio technology

Data/voice encryption
14 Mitel 6863 SIP / Mitel 6865 SIP
eud-1663/1.0 – R4.0 – 06.2015
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Operating your phone
Most keys and functions are described in the key legend. Other over-
views and operating aids can also be found here.

Overview system menu
Access to the system menu is made using the Menu. This contains the fol-
lowing menu entries. Refer to the relevant chapters of this user’s guide for 
further information on these menu entries.

Using the softkey/navigation key
Softkeys are the keys that are automatically configured with context-
dependent functions by the MiVoice Office 400 communications system. 
The functions are displayed on screen and operated with the navigation 
key.

A menu can have several sub-menus. Press the Execute softkey (down or 
right navigation) to access the sub-menu or the selection of possible edit-
ing options, or to carry out the action.

MiVoice Office 400 System men

1. Call list (depends on settings in theMiVoice Office 400 communication system)

2. Directory Lookup

3. Voice Mail

4. Forwarding

5. Presence

6. Call routing

7. Alarm melodies

8. Information
Mitel 6863 SIP / Mitel 6865 SIP 15
eud-1663/1.0 – R4.0 – 06.2015



 Keys, display and menu guidance
Free configurable keys
Mitel 6863 SIP: Your Mitel 6863 SIP  has three freely configurable keys 
that are preconfigured with the following default functions by your system 
administrator:

• System menu

• Redial list
• Call transfer. 

You can configure these programmable keys with another function or call 
number.

Mitel 6865 SIP: Your Mitel 6865 SIP has freely configurable keys. Popular 
functions are set up on a specific configurable key by default by your sys-
tem administrator (see  "Overview function key configuration (default key 
setting)", page 17). The remaining configurable keys can be configured 
with a specific action type: Call number, function, busy lamp field.

The key configuration is not made directly on the phone. Available settings 
for the key configuration:

• MiVoice Office 400 communication system: The configuration has 
already been made by your system administrator in the communication 
system.

• Self Service Portal: You can use the Self Service Portal (see chapter 
"MiVoice Office 400 Self Service Portal", page 8) where you can config-
ure, change or delete the keys however you wish.

More information on the configurable keys can be found in the chapter 
"Configuring keys", page 80.
16 Mitel 6863 SIP / Mitel 6865 SIP
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Overview function key configuration (default key 
setting)
Mitel 6863 SIP/Mitel 6865 SIP phones on the MiVoice Office 400 commu-
nication system are delivered with the following function key configuration. 
Please note that your system administrator may change this and your 
phone may therefore differ from this default configuration.

Function key Mitel 6863 SIP Mitel 6863 SIP if logged in as free seat-
ing phone

Key P1 System menu System menu

Key P2 Call list: Redial list Call list: Redial list

Key P3 Call transfer Call transfer

Function key Mitel 6865 SIP Mitel 6865 SIP if logged in as free seat-
ing phone

Key P1 System menu System menu

Key P2 Voice mail menu Free seating: Log in/out

Key P3 Request a callback Request a callback

Key P4 Empty1) Empty1)

Key P5 Empty1) Empty1)

Key P6 Empty1) Empty1)

Key P7 Empty1) Empty1)

Key P8 Empty1) Empty1)

1) The key assignment is configured with an empty function.
Mitel 6863 SIP / Mitel 6865 SIP 17
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 Keys, display and menu guidance
Overview alphanumeric keyboard
The alphanumeric keyboard can be used for entering digits and the pass-
word, for entering text and special characters, and also for quickdial. Press 
the relevant key repeatedly until the character you want is displayed.

The alphanumeric keyboard is configured with the characters from the fol-
lowing table. Please note that the actual character selection is dependent 
on the selected language.

Entering text
Entering digit and letters: In text mode, press the key repeatedly until the 
required character appears in the display.

Correcting entries: Use the left navigation key to correct any incorrect 
characters.

Upper case Lower case

1 . : ; = _ , - ’ & ( )

A B C 2 Ä Á À Â Ã Æ Å Ç А Б В Г a b c 2 ä á à â ã æ å ç a б в г

D E F 3 É Ê Д Е Ё Ж Э d e f 3 é è ê Д e ë ж з

G H I 4 Í Ï Î И Й К Л g h i 4 ì í ï î и й к л

J K L 5 М Н О П j k l 5 м н о п

M N O 6 Ñ Ö Ó Ò Ô Õ Ø Р С Т У m n o 6 ñ ö ó ò ô õ ø р с т у

P Q R S 7 ß Ф Х Ц Ч p q r s 7 ß ф х Ч ч

T U V 8 Ü Ú Ù Û Ш Щ Ъ Ы t u v 8 ü ú ù û ш щ ъ ы

W X Y Z 9 Ь З Ю Я w x y z 9 ь з ю я

0 +

* <Space>

# / \ @§
18 Mitel 6863 SIP / Mitel 6865 SIP
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Confirming entries: An entry or selection can be confirmed using the Run 
softkey.

Closing the editor without saving: With the Cancel softkey or the done 
key, you can cancel the entry without saving or go back to the idle state in 
the menu.

LED overview
The attention LED and LED in the function / line key signal different events 
and operating states with different colours and light statuses.

Message LED:

State Description

Flashes fast
• Incoming call
• Appointment call

Flashes slowly New voice message

Lit Phone locked

LED in line key:

State Description

Does not light up Line free

Flashes fast
• Incoming call
• Appointment call

Flashes slowly Call party on hold. Call be answered on any phone.

Lit Connected

LED function key or busy lamp field key (Mitel 6865 SIP only):

State Description

Does not light up
• Function is deactivated
• User free (busy lamp field)

Flashes fast
User is being called
(Busy lamp field)

Lit
• Function is activated
• User busy (busy lamp field)
Mitel 6863 SIP / Mitel 6865 SIP 19
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Using expansion key modules
The connection of expansion key modules to your phone 
(Mitel 6865 SIP only) gives you additional, freely configurable keys.

Expansion key module Mitel M680
You can connect up to three Mitel M680 expansion key modules next to 
each other on your phone. The Mitel M680 has the following properties:

• 16 configurable keys. Three expansion key modules would then give 
you an additional 48 configurable keys.

• Each key has an LED for visual signalling.

• The keys on the expansion key module support all key types that are 
supported by your phone's keys.

• The configurable keys of the expansion key module can be operated as 
the configurable keys of your phone.

• Keys must be configured by your system administrator or by yourself in 
the Self Service Portal (see "MiVoice Office 400 Self Service Portal", 
page 8).

• Labels for key identification (see chapter "Using labels", page 22).
20 Mitel 6863 SIP / Mitel 6865 SIP
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Expansion key module Mitel M685 
You can connect up to threeMitel M685 expansion key modules on your 
phone. The Mitel M685 has the following properties:

• Coloured touchscreen
• 3 key levels of 28 configurable keys each (84 configurable keys in total). 

Three Mitel M685 would therefore give you an additional 252 configur-
able keys.

• Each key has an LED for visual signalling.
• The keys on the expansion key module support all key types that are 

supported by your phone's keys.
• The configurable keys of the expansion key module can be operated as 

the configurable keys of your phone.
• Keys must be configured by your system administrator or by yourself in 

the Self Service Portal (see "MiVoice Office 400 Self Service Portal", 
page 8).

• If you remove an expansion key module or if you modify the order of the 
connected expansion key modules, the key configuration does not 
change.

• The display contrast setting and the display backlight is taken from your 
phone.

No. Key Description

1 A1-A84 function keys
(3 key levels, 28 keys 
each)

Freely configurable keys. An LED is located next 
to each function key signalling the functional 
state.

2 Function key for level 1, 
2, 3

Call up the desired level.

2

1
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Using labels

Printing and attaching the labels
Labels can be created and printed using the Self Service Portal (see chap-
ter "MiVoice Office 400 Self Service Portal", page 8).

Mitel 6863 SIP / Mitel 6865 SIP:

1. Label and print the write-on labels over the Self Service Portal (impor-
tant printer setting: "Page scaling for printing: None").

2. Cut out the labels according to the crop marks.
3. Remove the cover and insert the label into the recess.
4. Re-insert the cover into the recesses on the keypad.

Mitel M680 (Mitel 6865 SIP only):

1. Label and print the write-on labels over the Self Service Portal (impor-
tant printer setting: "Page scaling for printing: None").

2. Cut out the labels according to the crop marks.
3. Remove the cover and insert the label into the recess.
4. Re-insert the cover into the recesses on the keypad.
22 Mitel 6863 SIP / Mitel 6865 SIP
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The following sections explain the supplementary fea-
tures provided by your phone for more efficient use.

Making calls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Initiating calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Using functions before/while in a call  . . . . . . . . . . . . . . . 32

Using further functions. . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Overview of available functions. . . . . . . . . . . . . . . . . . . . 51

Organising absences from the desk . . . . . . . . . . . . . . . . 56

Operating call lists and voice messages . . . . . . . . . . . . . 60

Organisation within the team (busy lamp field, 
Mitel 6865 SIP only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Line keys on the key telephone (Mitel 6865 SIP only). . . 64

Using functions with OpenCount . . . . . . . . . . . . . . . . . . . 65

Setting functions by remote control . . . . . . . . . . . . . . . . . 66
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 Phoning
Making calls
This section explains how to set your calls.

Answering, ending or rejecting a call
Answering calls: The phone rings and the message LED and line key 
LED flash. If the caller's phone number is received, it is shown on the dis-
play. If the phone number is stored in the private phone book or in the 
MiVoice Office 400 communication system, the display also shows the cor-
responding name.

Open listening: With the open listening mode function, the loudspeaker is 
activated in addition to the handset so that other people in the room can 
listen to the call. You can continue with the call as usual using the handset.

Rejecting calls: As long as you have not picked up a call, you can reject it 
during the ringing phase.

Answering a call with the handset:
Pick up the handset.

Answer a call with the line key
Press the line key and pick up the handset.

Open listening during a call:
Activate: Press the Loudspeaker key.
Deactivate: Press the Loudspeaker key a second time.

Ending a call in open listening mode:
Press the Loudspeaker key and pick up the handset.

Note: If you merely replace the handset, the phone switches to the hands-free mode.

Ending a call:
Put the handset on-hook or press the End key.

Rejecting a call:
Press the End key during the ringing phase.
➔The connection is rejected and, depending on the system configuration, the 

caller either hears the busy tone or is forwarded to a preconfigured destina-
tion.
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Using your phone in hands-free mode
You want other people to join the conversation or to have your hands free 
while making the call.

The handsfree mode function activates the loudspeaker and the micro-
phone. Make sure the hands-free microphone is not obstructed. The 
sound quality is improved if you set the volume of your phone to a low set-
ting.

Muting the microphone
In the middle of a call you want to talk briefly with other persons in the 
room without your call partner hearing your conversation.

You can switch the microphone on and off during a call, regardless of 
whether you are using the handset, headset or handsfree system.

Answering/ending a call in handsfree mode:
Answer: Press the loudspeaker or the line key.
End: Press the End key.

Handsfree during a call:
1. Press the Loudspeaker key.

➔Open listening is activated.
2. Put the handset on-hook.

➔Handsfree is activated.

To continue the call with the handset:
Pick up the handset.
➔The loudspeaker and hands-free microphone are now deactivated.

Ending a call:
Put the handset on-hook.

Switching the microphone on and off during a call:
Activate: Press Microphone key.
Deactivate: Press the Microphone key once again.
➔The microphone is activated/deactivated. The LED on the Microphone key 

flashes/does not flash (Mitel 6865 SIP only).
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Using a headset (Mitel 6865 SIP only)
To make a phone call with the headset.

If you answer a call in headset mode using the Loudspeaker key, the call is 
provided on the headset. Alternatively you can also answer the call by 
picking up the handset.

All the headset mode configuration possibilities can be found in chapter 
"Setting the audio properties", page 70. Further information can be found 
in the user's guide for your headset.

Initiating calls
This section explains some convenient features provided by your 
phone for making a call.

Dialling with the phone number
You want to call someone and key in that person's phone number.

With call preparation you can enter a phone number without it being dialled 
automatically, so you have time to check the number and, if necessary, 
correct it. The number is not dialled until you go off-hook, for example by 
picking up the handset.

Answering a call with the headset:
Press the key on the headset or the Loudspeaker key.

Ending a call with the headset:
Press the key on the headset or the Loudspeaker key.

Dialling with the phone number:
Enter a phone number in call preparation.
Use the navigation key to the left to delete any incorrect character.

Pick up the handset or press the Dial softkey.

☛
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Dialling from the phone book (directory lookup)
You want to make a call by entering a name.

With directory lookup, you can search for an contact in your private phone 
book, system phone book or a connected external phone book. The 
response time may vary depending on the size and the number of phone 
books connected. The following search options are available:

Tips for
search
input:

• Press each of the corresponding digit keys once for the first few letters 
of the name you are looking for. For each letter, the display shows the 
corresponding digit, for example a "6" for the letter "n".

• Ask your system administrator whether you should start with the sur-
name or the first name.

• The search function is not affected by upper/lower case and special 
characters.

• More information on the phone books can be found in the chapter 
"Phone book management", page 75.

Menu Description

Quickdial With Quickdial you only need to press the digit keys for 
each letter once, even though each key is assigned sev-
eral letters. An efficient algorithm provides quick search 
results.

Dial by name Enter the corresponding letter for dialling by name.
The surname and first name have to be separated by a 
space (*-key).

Advanced search If you select Advanced search, you can search directly in 
the connected external phone books. This function is not 
available if no external phone book is connected.
The surname, first name and town each have to be sep-
arated by a space (* key), for example "no s so" for Noble 
Stephen in Solothurn.

Directory lookup:
Press the function key for Menu.

Scroll to Directory Lookup and press the navigation key to the right.

Scroll to Quickdial, Dial by name or Advanced search and press the navigation 
key to the right.
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Dialling from the call list
You want to call a user from one of the three call lists. You can choose 
from the following call lists:

Missed calls are signalled on the display.

Your phone automatically stored the person's phone number and name in 
a call list in the MiVoice Office 400 communication system. Within the one 
number user concept (see chapter "One number user concept", page 7) 
you can call back users through one of these call lists. The individual call 
lists include a maximum of 30 entries per list. More information on call lists 
can be found in "Editing options for the call list", page 60.

The call lists can be operated via the call list key, the redial key, the system 
menu, or a function key (see "Configuring keys", page 80).

Directory lookup with quickdial: Enter the first few letters of the name you 
are looking for using the corresponding digits.
Directory lookup with dialling by name: Enter the first few letters of the 
name you want.
Directory lookup with advanced search: Enter the first few letters of the 
name you are looking for and the town (each separated by a space).

Press the Execute softkey.
➔Names list (or List empty, if the phone is unable to find a matching user) is dis-

played.

Scroll through the list and select the user you want.

Pick up the handset.
➔The phone number displayed is dialled.

☛

Menu Description

Unanswered calls List of callers who tried to reach you when you were 
absent.

Answered calls List of calls answered.

Redial list List of calls made.

Call list for unanswered/answered calls:
Mitel 6863 SIP: Press the function key for Menu. Scroll to Call list and press the 
navigation key to the right.
Mitel 6865 SIP: Press the call list key.
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Dialling with a configurable key
You want to call someone whose phone number is stored under a config-
urable key.

To find out how to configure a configurable key, refer to the chapter "Con-
figuring keys", page 80.

Scroll to Unanswered or Answered and press the navigation key to the right.
➔The display shows a list of the last unanswered/answered calls.

Scroll through the list until the user you want is displayed.

Pick up the handset.
➔The call number of the user is dialled.

Note: Once the call has been successfully connected, the entry is deleted from the 
unanswered call list.

Redial list:
Press the Redial key.
➔List of the last dialled entries is displayed.

To scroll through the call numbers last dialled, press the navigation key down-
wards.

Pick up the handset.
➔The call number of the user is dialled.

Phoning with the handset:
1. Pick up the handset.
2. Press the desired configurable key.
➔The phone number is dialled.

Using your phone in handsfree mode:
Press the desired configurable key.
➔The phone number is dialled.
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Dialling with the line key
You want to make a call via a line key.

Mitel 6863 SIP: You can make a call via a line key. Your phone is 
equipped with two dedicated line keys with LED (L1, L2).

Mitel 6865 SIP: You can make a call via a line key. Your phone is 
equipped with two dedicated line keys with LED (L1, L2). Your system 
administrator can set up to seven additional line keys (making a total of 
nine). The actual number of line keys depends on the system configura-
tion. Press a fix line key directly or select a line by pressing the horizontal 
navigation key to the right or left. The display will show the line number 
(L1, L2 etc.).

You can switch the line by pressing the key. The active call is automatically 
put on hold locally.

Activating another Mitel phone for making calls
You want to make a call on another Mitel phone using your personal set-
tings, for example on a colleague’s phone or in a meeting room.

You can activate another Mitel phone to make an internal or external call 
using your personal settings, even if the phone is locked for external calls. 
You can activate the phone for a business or private call. Once you have 
activated the phone using a function code and your PIN, dialling by your 
private phone book is available. The called party's display shows your per-
sonal phone number and not the number of the phone from which you are 
making your call. Any call charges incurred will be charged to you.

Dialling with the line key:
Enter the phone number.

Press a free line key.
➔The phone number is dialled. The LED on the line key lights up.

Holding the call and switching lines:
1. Press a second, free line key or select a new line key with the horizontal nav-

igation key.
2. Enter the phone number.
➔The call is held on line key 1 and the call on line key 2 is active.

Note: Press line key 1 to return again to the call party on line 1 (see also "Brokering 
between an enquiry call party and your call partner", page 35).

☛
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Private call with PIN
You want to make a private call on your phone or on another Mitel phone.

With the aid of your PIN you can use any phone to make an external call 
with your own personal settings, even if that phone is locked for external 
calls. The called party's display shows your personal phone number and 
not the number of the phone from which you are making your call. Any call 
charges incurred will be charged to you. The call number dialled is not 
stored in the last-number redial list.

Business calls:
1. Enter function code #36 for a business call.
2. Enter your internal phone number.
3. Enter your PIN.
4. Enter the internal or external phone number with the exchange access digit.

Pick up the handset.
➔The phone number displayed is dialled.

Note: When you hang up, dialling by name and your private phone book remain avail-
able for a whole minute so you can make another call.

Private calls:
1. Enter function code #46 for a private call.
2. Enter your internal phone number.
3. Enter your PIN.
4. Enter the external call number directly, without the exchange access digit.
5. Pick up the handset.
➔The phone is now enabled; the external user is called.

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 73).

☛

☛

Private call with PIN:
1. Enter function code #46 followed by your internal call number.
2. Enter your PIN.
3. Enter the external call number directly, without the exchange access digit.

☛
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Using functions before/while in a call
This section explains the special features provided by your phone 
before you make a (second) call or while you are in a call.

Requesting a callback
You want to talk to a certain person. The person is busy or does not 
answer. You can make callback requests to both internal and external 
users. Not all providers support this function.

If the called party is busy, you can activate an automatic callback. In this 
case, your phone will start ringing as soon as the party you are trying to 
reach goes on-hook. When you pick up the handset, the person you want 
to call is dialled directly. If the called party does not answer, you can also 
request a callback. The user then obtains a message indicating your call-
back request on his display.

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Notes: • You can activate only one callback at a time.
• An unanswered callback request will automatically be cancelled by the 

system after about 30 minutes.

Pick up the handset.
➔The phone is now enabled. The external user is called.

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 73).

Activating callback:
You called someone and hear the busy tone or the ring-back tone. Press the 
function key for Callback.
➔Depending on the communication system you hear the acknowledgement tone.

Put the handset on-hook.
➔The display shows Call expected. The LED of the function key is switched on 

(Mitel 6865 SIP only).

Clear callback:
Press the function key for Callback. 
➔Callback request is deleted.
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To answer the callback request
Someone has asked you to call back. The display shows Callback.

You cannot automatically answer a callback request on your phone. You 
can either enter the call number manually or use a CTI client, for example 
the Mitel OfficeSuite.

Hide number
You do not want your call number to appear on the terminal display of a 
called party in the public network. The following options are available here:

This function must be saved to a configurable function key with Self Service 
Portal (see chapter "Configuring or deleting a key assignment", page 81).

Notes: • Your call number can only be hidden if you select an external call number.

• This feature depends on the range of services offered by your provider.

Answering the callback request:
Enter a phone number in call preparation.

Pick up the handset or press the Dial softkey.

Note: You cannot delete a callback request.

☛

Menu Description

Permanent The call number is never displayed.

Per call Call number should only be restricted for certain calls. 
This function must be activated before dialling the call 
number.

Activating/deactivating calling line identification restriction permanently:
Press the function key for Hide number.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Activating CLIR per call:
1. Press the function key for Hide number.
2. Enter the call number and press the Execute.

➔Call number is dialled and your own number is not displayed to the called party.
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Putting a call partner on hold
You want to briefly interrupt the active call.

You can put the call party on hold and then take them back again on the 
same phone.

Enquiry call during a call
You want to call someone else briefly without losing your current call part-
ner. Then you want to resume your conversation with your original call 
partner.

With the Enquiry function you can call someone else in the middle of a call 
and put your original call partner on hold. You can make enquiry calls to 
both internal and external users.

Putting the active call party on hold:
Press the Hold key.
➔The call party is put on hold. The LED on the line key flashes.

Take back the call party on hold:
Press the Hold key or the flashing line key.
➔The call is active again.

Setting up an enquiry call (you are in a call):
Press a free line key (select using the horizontal navigation key, if necessary).

Enter the call number of the enquiry partner and press the Dial.
➔Enquiry call party is called; first call partner is put on hold.

Notes: • You can also set up an enquiry call by pressing the busy lamp field key to 
which you have saved the enquiry call party.

• If the other user does not answer, you can cancel the enquiry call with the end 
key and take back the first call with the flashing line key.

Ending the enquiry call:
Press the End key.

Retrieving the first parked call party:
Press the flashing line key.

☛
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Brokering between an enquiry call party and 
your call partner
You are talking with an enquiry call party and have your first call partner on 
hold. You want to be able to switch back and forth between the two.

In an enquiry call you can use the brokering function to switch back and 
forth between an enquiry call party and the party on hold. Brokering is pos-
sible with both internal and external users. You can also broker between 
conference parties as a group and an enquiry call party.

Making a conference call
You want to make a conference call.

A conference call allows you to connect three call parties. From a confer-
ence call/call, you can initiate an enquiry call to someone else. You can 
broker between the conference participants and the enquiry call party. 
Depending on the system configuration, a conference call can consist of 
up to 6 conference participants. You can hold a conference call with inter-
nal and external users.

Mitel 6863 SIP: This function must be saved to a configurable function key 
with Self Service Portal (see "Configuring or deleting a key assignment", 
page 81).

Note: If you have a user account for the Self Service Portal, you can create con-
ference rooms there (see "MiVoice Office 400 Self Service Portal", 
page 8).

Brokering (to switch back and forth between the callers):
You are in an active call and have set up a connect to another call party with the 
Enquiry function.
Press the flashing line key.
➔Your call partner changes. The other call party is put on hold.

Note: You can also broker by pressing the busy lamp field key to which you have 
saved the call party.

Terminating a call:
Press the End key.

Retrieving the first parked call party:
Press the flashing line key.
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Mitel 6863 SIP:

Setting up a conference (you are connected):
1. Press the function key for Conference.
2. Enter the phone number of the conference call party.
3. Press the Dial softkey.

➔The conference party answers the call.
4. Press the function key for Conference.

Notes: • You can also set up a conference by pressing the busy lamp field keys to 
which you have saved the call party.

• You can change the procedure by first starting an enquiry call before you set 
up a conference.

Leaving a conference call:
Put the handset on-hook or press the End key.
➔The other conference parties remain in the call.

Mitel 6865 SIP:

Setting up a conference (you are connected):
1. Press the Conference key.
2. Enter the phone number of the conference call party.
3. Press the Dial softkey.

➔The conference party answers the call.
4. Press the Conference key.

Notes: • You can also set up a conference by pressing the busy lamp field keys to 
which you have saved the call party.

• You can change the procedure by first starting an enquiry call before you set 
up a conference.

Leaving a conference call:
Put the handset on-hook or press the End key.
➔The other conference parties remain in the call.
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Transferring a call
You want to put your call partner through to someone else.

With the call transfer function you can connect your call partner with some-
one else. You can connect internal and external users with one another. 
You can transfer the call with or without prior notice:

Mitel 6863 SIP: This function must be saved to a configurable function key 
with Self Service Portal (see "Configuring or deleting a key assignment", 
page 81).

Menu Description

Call transfer with prior 
notice

You only transfer the call after you have first talked to the 
second call party yourself.

Call transfer without 
prior notice

Without talking to the second call party, you transfer the 
call to them by hanging up the handset immediately after 
dialling the call number.

Mitel 6863 SIP:

Call transfer with prior notice (you are in a call):
1. Press the function key for Call transfer.
2. Enter the call number of the second call party and press the Select (or press 

the corresponding busy lamp field).
➔The second call party is called; first call party is put on hold.

3. Wait until the person has answered the call.
➔If the other user does not answer, you can cancel the second call with the 

Cancel softkey or with the End key and take back the first call.
4. Announce the call party.
5. Put the handset on-hook.

➔Your first call partner and the other person are now connected with each other.
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Call transfer without prior notice (you are in a call):
1. Press the function key for Call transfer.
2. Enter the call number of the second call party and press the Select (or press 

the corresponding busy lamp field).
➔The second call party is called; first call party is put on hold.

3. Wait for the first ring tone.
4. Put the handset on-hook.

➔The other party is then called directly by your first call partner.
➔Recall: If the other party does not answer, the call comes back to your phone.

Note: You can change the procedure by first starting an enquiry call before call transfer.

Mitel 6863 SIP:

Mitel 6865 SIP:

Call transfer with prior notice (you are in a call):
1. Press the forward key.
2. Enter the call number of the second call party and press the Select (or press 

the corresponding busy lamp field).
➔The second call party is called; first call party is put on hold.

3. Wait until the person has answered the call.
➔If the other user does not answer, you can cancel the second call with the 

Cancel softkey or with the End key and take back the first call.
4. Announce the call party.
5. Put the handset on-hook.

➔Your first call partner and the other person are now connected with each other.

Call transfer without prior notice (you are in a call):
1. Press the forward key.
2. Enter the call number of the second call party and press the Select (or press 

the corresponding busy lamp field).
➔The second call party is called; first call party is put on hold.

3. Wait for the first ring tone.
4. Put the handset on-hook.

➔The other party is then called directly by your first call partner.
➔Recall: If the other party does not answer, the call comes back to your phone.

Note: You can change the procedure by first starting an enquiry call before call transfer.
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Take (pick up own call)
You want to transfer a call from one phone to another without interrupting 
the connection (for example, from a desk phone to a cordless phone).

The take function can be used to transfer calls between your phones. 
Requirement: You are in the one number user concept (see "One number 
user concept", page 7).

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Starting announcement
You want to speak directly to an internal user or an announcement group 
via the loudspeaker - where available - without expecting an answer (simi-
lar to an intercom). The recipient is alerted to the announcement by two 
short signal tones. You are immediately unilaterally connected via the 
loudspeaker.

If the internal user has secured their phone against announcements (con-
figuration see chapter "Activating protection against call types", page 75), 
you cannot speak to them using an announcement. You will get the 
engaged tone.

The announcement function must be saved to a configurable function key 
with Self Service Portal (see "Configuring or deleting a key assignment", 
page 81). You can either configure the function key directly with a desig-
nated user or input the call number manually each time.

Announcement to a group:

• The announcement will only be received by phones which both have 
authorisation to receive announcements and are not in use.

• As soon as a user in a group picks up the handset to answer the 
announcement, the announcement is ended for all other users in the 
group.

Picking up your own call (you are in an active call):
Press the function key for Take.
➔After a brief moment, you are connected with the caller on another phone.
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• If receipt of announcements is not authorised on any of the phones in 
the announcement group or all the phones are in use, you will hear the 
busy tone.

• Group announcements are always conducted with a one-sided connec-
tion.

• The group number must be entered as two digits.

Receiving an announcement\
You will be alerted to the announcement with two short signal tones and 
spoken to directly via the loudspeaker across a one-sided connection. The 
display shows Announcement from.

In order to be able to receive an announcement, your phone must be nei-
ther in use nor locked against announcements (configuration see chapter 
"Activating protection against call types", page 75). To answer the 
announcement, the following options are available to you:

• You can continue the announcement as a phone call by picking up the 
handset.

• You can stop the announcement.

Announcement to a group:

• The announcement will only be received by phones which both have 
authorisation to receive announcements and are not in use.

• As soon as a user in a group picks up the handset to answer the 
announcement, the announcement is ended for all other users in the 
group.

Start announcement to a user:
Press the function key for <announcement to a user>. Depending on the set-
tings, enter the call number.
➔The user is alerted to the announcement by two short tones on the loud-

speaker. The one-sided connection is made, you can talk.

Start announcement to a group:
Press the function key for <announcement to a group>. Depending on the set-
tings, enter the two digit group number.
➔The user group is alerted to the announcement by two short tones on the 

loudspeaker. The one-sided connection is made, you can talk.
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• If receipt of announcements is not authorised on any of the phones in 
the announcement group or all the phones are in use, you will hear the 
busy tone.

• Group announcements are always conducted with a one-sided connec-
tion.

Recording a call
You want to record an active call with your call partner.

You can record an active conversation if you have been authorized to do 
so by your system administrator. Your call party can be an internal or an 
external user. The recordings are made and backed up only as .wave files 
in your individual e-mail boxes. For this, you must configure at least one e-
mail address in the MiVoice Office 400 communication system. You can 
find a call recording overview in your e-mail box. Contact your system 
administrator for more information.

You can start recording calls in the following situations:

• during an active call;
• During a conference call (with maximum two participants)

• During an incoming/outgoing call
• in call preparation;
• During dialling with a busy line.

Call recording only starts when the connection is set up. Therefore, no 
ring-back tones or wait tones are recorded.

You will be alerted to the announcement with two short signal tones and 
spoken to directly via the loudspeaker.
Continue an announcement as a phone call:
Pick up the handset.
➔You are on the phone with whoever started the announcement.
Note:
If the announcement was started to the group, all other recipients of the 
announcement will be excluded.

Stop announcement:
Press the End key.
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Call recording is temporarily interrupted during an enquiry and an e-mail is 
sent with the recording made up till then. Recording restarts automatically 
once the call connection with the enquiry call party is set up and/or once 
the call connection with the first correspondent is restored.

The maximum recording time for each .wave file depends on the system 
configuration. When the predefined or maximum recording time is 
reached, the recording stops automatically, the file is sent to your e-mail 
address and a new recording starts at the same time. Contact your system 
administrator for more information.

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Notes: • Recording calls may infringe on your national data protection provisions 
or be permitted only under certain circumstances. If you intend to use 
this function notify your call party in advance.

• You cannot record a conversation involving more than two call parties 
(enquiry call, conference). The recording is automatically stopped if you 
park your call party or put him on hold.

Activating discreet ring
You do not want to be disturbed by the ring of the phone. You do not, how-
ever, want to switch off the phone.

As an alternative to the usual ring, your phone has a discreet ring option. If 
you have activated discreet ring, the phone only rings once.

Recording a call:
Press the function key for Call recording: start/stop  as soon as you have an 
incoming/outgoing call or an active call.
➔The call is recorded. The LED on the function key is switched on 

(Mitel 6865 SIP only).

Stopping the call:
End the recording using also the function key for Call recording: start/stop.
➔The recording is sent to your e-mail address.

Note: The LED on the function key remains lit while the recording is in progress. The 
LED starts to flash before the recording reaches its maximum preset duration. 
Once the maximum duration is reached (or the memory is full), the recording is 
stopped and the LED goes off (Mitel 6865 SIP only).
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This function must be saved to a function key over the Self Service Portal 
(see "Configuring or deleting a key assignment", page 81).

Activating do not disturb
You do not want to receive any calls for the time being.

With the do not disturb function, you can stop calls being made to you if 
you are busy in a call or are not otherwise able to take any calls. Your 
phone does not ring and is set to busy for incoming calls. Your incoming 
calls are automatically forwarded to a call forwarding destination that has 
been configured by your system administrator.

Your system administrator must enable this function in the MiVoice 
Office 400 communication system.

This function must be saved to a function key over the Self Service Portal 
(see "Configuring or deleting a key assignment", page 81).

Activating/deactivating discreet ring:
Press the function key for Discreet ring on/off.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Menu Description

Do not disturb (busy) 
on/off

Your phone does not ring and is set to busy for incoming 
calls.

Do not disturb (for-
warding) on/off

Your phone does not ring and is set to busy for incoming 
calls. Incoming calls are automatically forwarded to a 
destination that has been configured by your system 
administrator.

Activating/deactivating do not disturb:
Press the function key for Do not disturb (busy) on/off or Do not disturb (forward-
ing) on/off.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only). Your callers hear the busy tone.
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Activating intrusion/answering
You want to implement intrusion in a current call.

Intrusion allows you to access a current call between two call parties and 
listen to their conversation. The call party to which you have initiated intru-
sion is notified (display and sound signals). Your call party can then 
respond () to intrusion or reject it.

You can block intrusion; see "Protecting yourself against calls", page 75.

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Notes: • Your system administrator must grant you intrusion rights.

• Intrusion may infringe on your national data protection provisions or be 
permitted only under certain circumstances. If you intend to use this 
function, you should therefore notify your call party in advance.

Activating/answering silent intrusion
Silent intrusion (intrusion without prior notice) is a variation of the intrusion 
function and is used primarily in call centres.

Another user can connect to your active call and listen to the conversation 
without you or your call party noticing. Unlike with intrusion, there is neither 
a display nor a sound signal to indicate use of the function.

Activating intrusion (the users are talking):
1. Press the function key for Intrusion.
2. Enter the call number of the user you want as per the key configuration.
➔The intrusion tone indicates that the function has been activated.
➔If the user has blocked intrusion, connection set up will be cancelled.

Answering intrusion:
Press the Answer softkey.
➔You will be connected with the user who has activated intrusion; the first call 

party is put on hold.

Rejecting intrusion:
Press the End softkey.
➔Intrusion will be rejected; you remain connected to your first call party.
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You cannot reject silent intrusion (but you can block it; see "Protecting 
yourself against calls", page 75). The microphone of the third user remains 
off. The third user can, however, enter the conversation at any point by 
enabling his or her microphone or pressing the intrusion function key.

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Notes: • Silent intrusion must be enabled in the communication system.
• Your system administrator must grant you silent intrusion rights.
• Silent intrusion may infringe on your national data protection provisions 

or be permitted only under certain circumstances. If you intend to use 
this function, you should therefore notify your call party in advance.

Using further functions
This section explains some more convenient features provided by 
your phone. All the functions you can save under a configurable key 
can be found in chapter "Overview of available functions", page 51.

Activating personal call routing
You want to specify which of your phone shall ring when you receive a call.

You can specify the phone on which a call is signalled with personal call 
routing.

Your system administrator has set you up multiple phones with the same 
phone number in the one number user concept (see "One number user 
concept", page 7). The system administrator has also assigned you per-

Activating silent intrusion (the users are talking):
1. Press the function key for Silent intrusion.
2. Enter the call number of the user you want as per the key configuration.
➔The function is activated.
➔If the user has blocked intrusion, connection set up will be cancelled.

Answering silent intrusion:
There are neither display nor sound signals on your phone to indicate silent 
intrusion.
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mission to configure routing in the Self Service Portal. This allows you to 
set up 5 routings in the Self Service Portal for a range of situations 
("Office", "Home Office", "On the road").

You can only answer a call on the phone on which the call is signalled. If 
you have not configured a call routing, the default setting (all phones are 
ringing) is used as standard. The following options are available on your 
phone for further editing of personal call routing:

You can also store your individual call routing profiles over the Self Service 
Portal on a function key and quickly activate or deactivate your desired call 
routing profile by simply pressing that key.

Menu Description

Activate Activating personal call routing.

Modify Renaming personal call routing.

Change settings The personal call routing settings can only be changed 
by your system administrator or yourself in the Self Ser-
vice Portal.

Delete A personal call routing can only be deleted by your sys-
tem administrator or yourself in the Self Service Portal.

Activating/deactivating personal call routing
Press the function key for Menu softkey.

Scroll to Pers. call routing and press the right navigation key to the right.
➔A list of your routings is displayed.

Select the call routing you want and confirm with the Activate > Run softkey.
➔The selected routing is activated and another is deactivated.

Renaming personal call routing:
Press the function key for Menu softkey.

Scroll to Pers. call routing and press the right navigation key to the right.
➔A list of your routings is displayed.

1. Select the call routing you want and confirm with the Modify > Run softkey.
2. Enter the name and confirm with the Execute softkey.
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Activating ring alone
You want to specify the phone on which an incoming call is signalled 
acoustically.

If your system administrator has set up one phone number with several 
phones (see  "One number user concept", page 7),you can use Ring Alone 
to define on which phone a call is to be signalled acoustically. As soon as 
you activate Ring Alone on one phone, the ring tone is deactivated for all 
other phones. An incoming call is signalled in the display of all phones. 
You can answer the call on each of your phones.

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Note: When you have activated ring alone but deactivated the personal call rout-
ing for a phone in parallel, an incoming call is not acoustically but only vis-
ually signalled.

Locking/Unlocking your phone
You need to leave your desk and want to ensure that no-one can alter your 
phone's settings, look at your private data, or make calls from your phone.

You can lock your phone with a 2  to10-digit PIN (for more information on 
the PIN, see "Changing the PIN", page 73).

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Press the function key for the desired call routing profile.
➔Call routing is activated/deactivated. The LED on the function key is switched 

on/off (Mitel 6865 SIP only).

Activating/deactivating ring alone
Press the function key for Ring Alone on/off.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).
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Acknowledging an appointment call
You can set a call to remind you about an appointment, for example. 
Appointment call is displayed as soon as it is received. Without acknowl-
edgement, the appointment call will ring for 1 minute.

The following options are available: You have to enter or change the time 
in the Self Service Portal.

This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

Notes: • If you activated forwarding, the appointment call is not forwarded.
• If you are in call, the appointment call is made as soon as you end the 

call.

Activating the phone lock:
Press the function key for Phone lock on/off.
➔The phone is locked and can only be unlocked using your PIN.

Deactivate the phone lock:
1. Press the function key for Phone lock on/off.
2. Enter the PIN and confirm with the Execute softkey.
3. Unlock the security prompt with the Unlock softkey.

Note: Use the following function codes (see also User Guide Function Codes user's 
guide on the Mitel DocFinder), to activate or deactivate the phone lock for all 
phones within the one number user concept (see "One number user concept", 
page 7):
• Activating the phone lock: Enter the function code *33* <PIN> #
• Deactivate the phone lock: Enter the function code #33* <PIN> #

Menu Description

Single appointment 
call on/off

Activate appointment call on a one-off basis.

Repeat appointment 
call on/off

Activate appointment call permanently
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Free seating
Free Seating is proposed for workplaces/phones shared by several 
employees. It allows you to log in on each free free seating phone and to 
use it with your personal settings as long as your logged in. Ask your sys-
tem administrator which phones are proposed for free seating.

Log in:

You log in with your call number and your PIN on a free seating phone. 
Once you are logged in, your personal call lists, phone book and all your 
other personal settings and Hotkeys are available to you immediately. If 
your profile contains expansion key modules, but the phone you have 
logged in to does not, the keys in question will not be available to you. Var-
ious sequences of expansion key modules are correctly recognised.

Notes: • You can only log in to a phone if no other user has yet logged in to that 
phone for free seating purposes.

• You can only log on once to a Free Seating phone. The moment you log 
in to another free seating phone, you are automatically logged off the 
original phone.

Log out:
To free up a phone, you need to log off again. To ensure a phone is not 
blocked for other users if you forget to log off, your system administrator 
can set up a logoff process with an automatic time limit:

• After a certain amount of time after login (e.g. 6 hours and 30 min.).
• At a certain time (e.g. 6:30pm)

Activates/deactivates appointment call permanently:
Press the function key for Appointment call.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Activate single appointment call:
Press the function key for Appointment call.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Confirming an appointment call:
Pick up the handset and then hang up immediately.
➔The appointment call is confirmed and ended.
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Notes: • If no user is currently logged in a free seating phone, possibly only 
emergency calls are allowed.

• As long as you do not have your own phone or are not logged on to a 
Free Seating phone, your caller will obtain either the busy signal or be 
forwarded to a preconfigured destination, depending on the system 
configuration.

Hotline
The hotline is typically used for lift phones, emergency phones, or for baby 
alarms or hotline in the hospitality/hotel branch.

A user needs help and picks up the handset or presses the Loudspeaker 
key. The user is automatically routed to the preconfigured hotline destina-
tion number stored in the MiVoice Office 400 communication system. The 
person responsible answers the call and is connected with the user seek-
ing help.

Alarm cancellation delay: Your system administrator can set a delay (0-
60 seconds, depending on the Mitel system phone). During this delay the 
user can enter another call number in order not to trigger a call on the hot-
line destination number. If the user does not dial another phone number 

Log in free seating:
Press the Free Seating: Log in/out softkey.

Enter phone number and PIN and confirm with the OK softkey.
➔You are now logged in and can use the free seating phone with your personal 

settings. The LED on the function key is switched on (Mitel 6865 SIP only).

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 73).

Log out free seating:
Press the Free Seating: Log in/out softkey.
➔The display with the call number is displayed.
Depending on the system configuration enter the PIN and confirm with the OK 
softkey.
➔You are now logged off; the free seating phone is now available again to other 

users.

Note: You are automatically logged off if your system administrator has set up an auto-
matic logoff process.

☛
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during this predefined time or puts the handset back down again, a con-
nection with the Hotline number is automatically set up. Contact your sys-
tem administrator for more information.

Overview of available functions
This section contains a list of all the functions you can store under a con-
figurable key via the Self Service Portal. Please note that the selection of 
functions depends on the selected phone and its authorisation level.

More information on how to save functions to a configurable key using 
function commands and a function code can be found in the online help for 
Self Service Portal (see "MiVoice Office 400 Self Service Portal", page 8).

Using the hotline:
User needs help. He picks up the handset of his phone or presses the Loud-
speaker key.
➔A connection with the hotline number is automatically set up after a prede-

fined time without the user having to do anything else.

Function Description

Agent: Log in/out Log in/out to/from the queue as an agent (control of 
routing in the queue).

Agent: Wrap-up time log 
in/out

Activate/deactivate agent wrap-up time.

Agent: Break log in/out Activate/deactivate agent break.

Show alarm state Display of the current alarm state.

Picking up a call from a 
user group

Pick up a call for another user in the user group.

Park call Keep a call party on hold without keeping a phone 
line busy. This function is not available in Release 
4.0.

Call list: Answered calls Call list for answered calls.

Call list: Menu Direct access to the system menu Call list.

Call list: Unanswered callsCall list for unanswered calls.

Call list: Redial list Call list for dialled call numbers.

Do not disturb (busy) 
on/off

Your phone does not ring and is set to busy for 
incoming calls.
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Do not disturb (forward-
ing) on/off

Your phone does not ring and is set to busy for 
incoming calls. Incoming calls are automatically for-
warded to a destination that has been configured by 
your system administrator.

Call forw. if busy (CFB) to 
user on/off

If you are busy, incoming calls will be forwarded to 
specific destination (user).

Call forw. if busy (CFB) to 
VM on/off

If you are busy, incoming calls will be forwarded to 
specific destination (voice mail).

Call forw. (CFU) to user 
on/off

Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to pager 
on/off

Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to text 
message on/off

Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to VM 
on/off

Incoming calls are automatically forwarded to a spe-
cific destination.

Call forwarding menu Direct access to the Forwarding (see chapter "Call 
forwarding", page 58).

Presence menu Direct access to the Presence (see chapter "Con-
trolling the presence status", page 56).

Presence profile on/off Activate/deactivate presence profile. You can select 
a presence profile (profile number 1-4, see chapter 
"Controlling the presence status", page 56).

Intrusion This function allows you to intrude to a busy user's 
call with notification (see chapter "Activating intru-
sion/answering", page 44).

Welcome announcement 
on/off

Announcement service for incoming internal and 
external calls. If you do not answer an external call 
after a set delay, the user who is calling will obtain an 
announcement. After the announcement the caller 
will then hear the ring-back tone again.

Discreet ring on/off When this function is on, the phone only rings once. 
For further information, please see "Activating dis-
creet ring", page 42.

Announcement to user Speak directly to an internal user via the loudspeaker 
- where available - without them having to first pick up 
the call. An announcement is a one-sided connection 
and is indicated by two short signal tones on the 
recipient phone.

Function Description
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Announcement to group Speak directly to a group of internal users via the 
loudspeaker - where available - without them having 
to first pick up the call. An announcement is a one-
sided connection and is indicated by two short signal 
tones on the recipient phone. Announcement groups 
will be defined by your system administrator. The 
group number must be entered as two digits.

Remote maintenance 
on/off

Allow permanent remote management access on 
your phone.

Remote maintenance 
onetime on/off

Allow one-time remote management access on your 
phone.

Free seating: Log in/out Log in/out on a free seating phone (see "Free seat-
ing", page 49).

Free configurable You can use function commands to define a function 
to suit your personal requirements. A function can 
consist of one or more function commands, function 
codes, and the phone number. You can either carry 
out a function directly or store it under a key.

Start/stop call recording Record a call. The recordings are stored in your indi-
vidual e-mailbox only (see "Recording a call", 
page 41).

Call transfer Transfer a call to another user with or without prior 
notice.

Home Alone on/off If calls to a user group can only be answered by one 
user, the user in question can activate Home Alone 
on the user group. Then if the user is already in a call, 
all subsequent internal or external calls to the user 
group obtain a busy tone.

Set up conference Set up a conference with two call parties.

Empty The key assignment is configured with an empty 
function. The key is not overwritten by the following 
key assignments.

Personal call routing 
menu

Direct access to the Routing (see chapter "Activating 
personal call routing", page 45).

Personal call routing 
on/off

Activate/deactivate call routing profile (under the one 
number user concept).

PIN call Function with OpenCount. Independently from the 
phone you can make external calls for a fee. The 
credit may be limited (see chapter "Activating PIN 
telephony", page 65).

Function Description
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PIN call rebook Function with OpenCount. You can charge the 
charges and the call information of your outgoing and 
incoming calls to specific projects (see chapter "Acti-
vating PIN telephony", page 65).

Ring Alone on/off This function lets you specify which of your phones 
signals incoming calls acoustically (as part of the 
one-number user concept, see chapter "Activating 
ring alone", page 47).

Request a callback Request a callback if the called party is busy or can-
not be reached (see "Requesting a callback", 
page 32).

Hide number on/off Permanently prevents your call number from being 
displayed to the caller (see chapter "Hide number", 
page 33).

Hide number per call Prevent your call number from being displayed to the 
caller once (see chapter "Hide number", page 33).

Call forw. on no reply 
(CFNR) to user on/off

Incoming calls are automatically forwarded to 
another destination (user).

Call forw. on no reply 
(CFNR) to pager on/off

Incoming calls are automatically forwarded to 
another destination (pager).

Call forw. on no reply 
(CFNR) to VM on/off

Incoming calls are automatically forwarded to 
another destination (voice mail).

User group: Log in/out Log in/out of a user group. In the user group incoming 
and internal calls are routed to a group of internal 
destinations according to a preconfigured call distri-
bution.

User group, all: Log in/outLog in/out of all user groups. In the user group incom-
ing and internal calls are routed to a group of internal 
destinations according to a preconfigured call distri-
bution.

Switch group x, position 2
Switch group x, position 3

This function lets you route calls and functions via 
switch groups (with two switch positions).

Call forwarding protection 
on/off

Call forwarding to your phone is not allowed.

Control output on/off You can control external electric equipment or instal-
lations using control outputs. For example you can 
use your phone to open and close electric gates or to 
switch the lights on or off throughout a building.

Function Description
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Silent intrusion This intrusion without prior notice function allows you 
to intrude to a busy user's call without notification 
(see "Activating/answering silent intrusion", 
page 44).

System menu Access to the MiVoice Office 400 system menu.

Take (pick up own call) Take a call from your phone on another phone under 
the one number user concept (see chapter "Take 
(pick up own call)", page 39).

Phone lock on/off Activate/deactivate phone lock. Outgoing calls are 
not possible, but incoming calls can be answered 
(see chapter "Locking/Unlocking your phone", 
page 47).

Phone book: local Access to your local phone book. Contacts in the 
local phone book are stored on the phone only (see 
chapter "Phone book management", page 75).

Telefonbuch: System Direct access to the Directory Lookup system menu . 
Contacts in the system phone book are integrated in 
the MiVoice Office 400 communication system (see 
chapter "Phone book management", page 75).

Repeat appointment call 
on/off

Activates/deactivates an appointment call (see chap-
ter "Acknowledging an appointment call", page 48).

Single appointment call 
on/off

Activates/deactivates an appointment call on a one-
off basis (see chapter "Acknowledging an appoint-
ment call", page 48).

Transparent data This function takes charge of the transparent 
exchange of data between the communication server 
and external applications.

Record voice mail greet-
ing

Records a selected voice mail greeting.

Voice mail greeting on/off Activates/deactivates a selected voice mail greeting.

Play voice mail greeting Plays back a selected voice mail greeting.

Voice mail menu Direct access to the Voice Mail system menu.

Run XML function You system administrator creates customer-specific 
XML services (weather report, stock exchange, etc.) 
which you can use on your SIP phone.

Function Description
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Organising absences from the desk
This section explains the different options provided by your phone 
when you want to leave your desk.

The presence function enables you on the one hand to quickly set 
your personal presence state and hence to route the incoming calls 
to the destination you want. It also tells you directly whether the user 
you want is reachable or absent without you having to call him. The 
information details depend on the type of telephone.

Controlling the presence status
You have a choice of 5 presence profiles for controlling your presence sta-
tus:

You can call up the presence of the user you want in the following situa-
tions.

• in Directory Lookup
• in a call list
• during connection set up

Notes: • Connected CTI applications can affect your presence status. Contact 
your system administrator for more information.

• All configuration options for a presence profile can be found in chapter 
"Configuring presence profile", page 78.

Operation of the presence status is available via the system menu, a func-
tion key (see chapter "Configuring keys", page 80), or the  Self Service 
Portal (see chapter "MiVoice Office 400 Self Service Portal", page 8).

Profile number Presence profile

0 Available (default)

1 Absent

2 Meeting

3 Busy

4 Not available
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Absence information
You wish to give your caller detailed information about your absence.

If you have configured call forwarding to voice mail in your presence pro-
file, you can choose whether the currently active greeting, the global greet-
ing, one of your personal greetings or an absence information should be 
played back to the caller.

Absence information is available for each presence profile, with the excep-
tion of Available. Absence information consists of a language-dependent, 
predefined audio text. The time and/or date are also given as an option. 
Depending on the voice mail configuration your caller then has immedi-
ately the possibility of leaving a message.

Example: "The person you have called is not available until 31st January, 
at 14:00. Please leave a message after the tone".

The absence information is an integral part of a presence profile. All the 
relevant configuration possibilities can be found in chapter "Configuring 
keys", page 80.

Note: If your Outlook calendar is not synchronised via Mitel Open Interfaces 
Platform (OIP) with your communication server, you have to manually 
enter and delete the time and date.

To deactivate the presence profile:
Press the function key for Menu softkey.

Scroll to Presence  and press the navigation key to the right.

1. Select the presence profile you want and press the Execute softkey.
2. Press the Activate > Execute softkey.

Set up the absence information:
Press the function key for Menu softkey.

Scroll to Presence  and press the navigation key to the right.
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Call forwarding
You want to leave your desk. Calls for you are to be forwarded to a differ-
ent destination (e.g. another user, your voice mail).

With call forwarding, you can forward incoming calls directly to a different 
destination.

Notes: • One call forwarding applies to all connected phones, in one number 
user concept.

• Only one call forwarding variant at a time is possible.

The following call forwarding options are available for selection:

1. Select the presence profile you want and press the Execute softkey.
2. Scroll to Modify and press the Enter softkey.

1. Scroll to Time or Date and press the softkey Enter softkey.
2. Make the changes and confirm with the Enter softkey.
3. Scroll to Call forwarding and press the Enter softkey.
4. Select Voice Mail and confirm with the Enter softkey.
5. Scroll to VM greeting and press the Enter softkey.
6. Select Absence information and confirm with the Enter softkey.
7. Activate the presence profile.
➔Settings are saved. Your caller hears the selected absence information, fol-

lowed, if applicable, by time and date.

Menu Description

No call forwarding (Call 
forwarding off)

No CFU is carried out.

Always call forwarding, 
CFU (Always (CFU))

Incoming calls are automatically forwarded to another 
destination.

Call forwarding if busy, 
CFB (If busy (CFB))

Incoming calls are forwarded directly to a different desti-
nation if you are busy.

Call Forwarding on No 
Reply

Incoming calls are automatically forwarded to another 
destination. Both your own phone and the other destina-
tion will then start ringing. The system configuration 
determines whether or not there is a ringing delay at the 
other destination. Whoever goes off-hook first, answers 
the call. Depending on the system configuration, Call 
Forwarding on No Reply can also be activated when 
your phone is busy.
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Available call forwarding destinations:

Operation of the call forwarding is available via the system menu, a func-
tion key (see chapter "Configuring keys", page 80), or the Self Service Por-
tal (see chapter "MiVoice Office 400 Self Service Portal", page 8).

Menu Description

User Incoming calls are forwarded to an internal user or a call 
number.

Voice Mail Incoming calls are forwarded to your voice mail, provid-
ing it has been set up by your system administrator.
You can use the global greeting or your own greeting 
(see chapter "Configuring voice mail", page 76). For fur-
ther information on voice mail refer to the User Guide 
Voice Mail Systems on the Mitel DocFinder.

Activating call forwarding:
Press the function key for Menu softkey.

Scroll to Forwarding and press the navigation key to the right.

Select the call forwarding variant you want and confirm with the Execute softkey.

Select or enter the forwarding destination you want and confirm with the Exe-
cute softkey.
➔The call forwarding is activated.

Note: You can also enter the call number of the user you want manually or find it in a 
call list.

Deactivate call forwarding:
Call forwarding unconditional can be deactivated via: Menu > Forwarding > for-
warding variant Forwarding off.
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Operating call lists and voice messages
In this section, you will learn how to use call lists and voice mes-
sages which are stored in the MiVoice Office 400 communication sys-
tem.

Editing options for the call list
The call lists (unanswered/answered calls and redial list) include a maxi-
mum of 30 entries each. Missed calls are signalled on the display. The fol-
lowing options are available for further editing of the entries:

The call lists can be operated via the call lists key, the system menu or a 
function key, or via the redial key (see "Configuring keys", page 80).

More information on call lists can be found in "Dialling from the call list", 
page 28.

Menu Description

Delete all Deleting all entries from a specific call list.

Detail Available detailed information:
• Call number / name
• Call date and time
• Number of call attempts
• Presence status of the user

Delete Delete entry.

Note: If you delete an entry in the unanswered calls list, then 
any voice messages for this entry are also deleted. 
Entries with voice messages that have not been 
retrieved cannot be deleted.

Dial Calling a user back.

Options in the call list:
Mitel 6863 SIP: Press the function key for Menu softkey. Scroll to Call list and 
press the navigation key to the right.
Mitel 6865 SIP: Press the call list key.

1. Scroll to the call list you want and press the Execute softkey.
2. Scroll through the list until the user you want is displayed.
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Editing options for voice messages
Your display shows the envelope symbol and the number of new voice 
messages. The message LED flashes red slowly.

The following options are available for further editing of the voice mes-
sages:

Notes: • Depending on the system configuration your system administrator can 
specify that you are notified by e-mail whenever you receive a new 
voice message (with the voice message attached). Contact your system 
administrator for more information.

• To find out how to configure a voice mail, refer to the chapter "Configur-
ing voice mail" or to the User Guide Voice Mail Systems user guide on 
the Mitel DocFinder.

Calling a user from the call list:
Pick up the handset.
➔The call number of the user is dialled. Once the call has been successfully 

connected, the user is deleted from the unanswered call list.

Calling up detailed information on an entry:
1. Select the entry you want and press the Execute softkey.
2. Call up detailed information with the Detail > Enter softkey.

Deleting an entry from the call list:
1. Select the entry you want and press the Execute softkey.
2. Delete the entry with the Delete > Enter softkey.

Deleting all entries from the call list:
1. Select an entry and press the  Execute softkey.
2. Delete all entries with the Delete all > Execute softkey.

Menu Description

Detail Available detailed information:
• Call number / name
• Call date and time

Delete Delete voice message

Forward Forwards a voice message to another user. You can 
decide whether to keep a copy of each voice message.

Play Play voice message.
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Operation of the voice messages is available via the system menu, a func-
tion key (see chapter "Configuring keys", page 80), or the Self Service Por-
tal (see chapter "MiVoice Office 400 Self Service Portal", page 8).

Organisation within the team (busy lamp 
field, Mitel 6865 SIP only)
This section explains the different options provided by your phone to 
communicate in a team.

Using the busy lamp field key
You and your team partners want to be reachable at all times as a team 
and be able to communicate with one another as quickly as possible.

Options in the voice mail:
Press the function key for Menu softkey.

Scroll to Voice mail and press the right navigation key.
➔The list of received voice messages is displayed.

Play voice message:
1. Select the entry you want and press the Execute softkey.
2. Play the entry with the Play > Enter softkey.

Calling up detailed information on a voice message:
1. Select the entry you want and press the Execute softkey.
2. Call up detailed information with the Detail > Enter softkey.

Deleting a voice message:
1. Select the entry you want and press the Execute softkey.
2. Delete the entry with the Delete > Enter softkey.

Forwarding voice messages:
1. Select the entry you want and press the Execute softkey.
2. Press the Forward > Enter softkey.
3. Select the call number you want and press the Execute softkey.
4. If you wish to keep a copy of the voice message, answer the questions with 

the End > Yes > Enter.
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By pressing a single key you can call a team partner or answer a call for 
anyone in the team. When a team partner makes a call, the LED for the 
corresponding busy lamp field key lights up. This tells you when a team 
partner is busy. The busy lamp field key LED flashes to indicate that the 
team partner is receiving a call.

• More options with the busy lamp field that are not described here can 
be found with the corresponding function.

• A busy lamp field can only be saved on function keys T1 to T20 
(Mitel 6867 SIP) or function keys T1 to T40 (Mitel 6869 SIP).

To be able to use the busy lamp field key, it must have been configured as 
such with the call number of the team partner, either by your system 
administrator or by yourself in the Self Service Portal (see chapter "Config-
uring keys", page 80).

Calling a team partner
You want to call a team partner as quickly as possible.

Answering a call for a team partner
Your team partner is called. The LED on the busy lamp field key flashes. 
You know that your team partner is not at his desk at present and therefore 
decide to answer the call.

You take over the call by pressing the busy lamp field key. As soon as you 
have answered the call, your team partner is free again.

Calling a team partner:
Press the busy lamp field key of the team partner.
➔The phone number and possibly the name of the team partner appear on the 

display. The team partner is called.

Answering a call for a team partner:
Pick up the handset as long as the busy lamp field key LED is flashing.
➔You hear the dialling tone.

Press the busy lamp field key.
➔You are through to the person who is calling your team partner.
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Line keys on the key telephone 
(Mitel 6865 SIP only)
This section explains the different options provided by your phone 
when your system administrator has assigned one of more configur-
able keys as KT line keys. KT line keys make your phone a key tele-
phone.

A KT line has a number which can be used for internal or external calls. 
One or usually multiple phones can be connected to this KT line, for exam-
ple in all employees in a travel agency who work with Europe as a destina-
tion. The KT line key belonging to the KT line shows the status of the KT 
line through an LED and allows you to accept calls which are made to this 
KT line.

Your phone becomes a key telephone as soon as your system administra-
tor has assigned a KT line to a configurable key. With the configuration of a 
KT line key, your system administrator will also set up a personal line on 
which you can make your personal calls.

KT lines are only possible on function keys T1 to T20 (Mitel 6867 SIP) or 
T1 to T40 (Mitel 6869 SIP).

Answering a call on the KT line key
You are being called on one or more KT line keys. The KT line key(s) flash 
quickly. You want to answer a call on a KT line key.

If you want to answer a call on another KT line key first, press this KT line 
key in order to pick up the call. If you pick up the handset without pressing 
a KT line key, you will be connected to the highest priority KT line.

Pick up the handset.
➔Connection to the KT line with the highest priority.
Or:
1. Press KT line key.
➔KT line is selected.
2. Pick up the handset.
➔Connection to the selected KT line.
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Initiating a call via a KT line key
You want to make a call via a KT line key.

You can call via any free KT line key. Each KT line key has its own call 
number. This means that, by phoning, you transmit the call number associ-
ated with the active KT line key.

Charges are accrued separately for each KT line key.

Using functions with OpenCount
OpenCount is a software package used for the call logging manage-
ment on the communication system. The application can be inte-
grated into your MiVoice Office 400 communication system and ena-
bles the logging, the administration, and the analysis of all call and 
connection data.

If an OpenCount is integrated in your MiVoice Office 400 communica-
tion system, the following additional features are also available on 
your phone.

Activating PIN telephony
The PIN telephony is part of OpenCount. The possible applications of the 
PIN telephony depend on the area of use, for example in the area of health 
care and accommodation/hotel:

• Independently from the phone you can make external calls for a fee. 
The credit may be limited.

• You can charge the charges and the call information of your outgoing 
and incoming calls to specific projects.

Enter the phone number.

Press a free KT line key.
➔The LED on the KT line key lights up. KT line is selected.

Pick up the handset.
➔The phone number is dialled.

☛
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This function must be saved to a configurable function key with Self Ser-
vice Portal (see chapter "Configuring or deleting a key assignment", 
page 81).

For further information, please refer to the product-specific OpenCount 
user guides on our website (www.mitel.com) or contact our system admin-
istrator.

Setting functions by remote control
This section explains how you can alter your phone’s settings even if 
you are not directly at your phone.

You are not at your desk and want to set various functions on your phone 
from a different phone.

You can activate/deactivate many of your phone's functions by remote 
control from a different phone.

The remote control is initiated using a special function code. You can then 
enter the function commands and function codes.

Activating/deactivating PIN call:
Press the function key for PIN call / PIN call rebook.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Using remote control from a third-party phone:
1. Enter function code #06.
2. Enter your phone number.
3. Enter your PIN.
4. Enter the function code for activating/deactivating the function you want.

Pick up the handset.
➔You hear the acknowledgement tone.

Put the handset on-hook.
➔The function is activated/deactivated.

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 73).

☛
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Personalizing your phone

These sections explain how to adapt the phone’s basic 
settings to suit your personal requirements.

Configuring the display  . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Configuring the audio properties . . . . . . . . . . . . . . . . . . . 69

Configuring general phone settings. . . . . . . . . . . . . . . . . 71

Protecting yourself against calls  . . . . . . . . . . . . . . . . . . . 75

Phone book management . . . . . . . . . . . . . . . . . . . . . . . . 75

Configuring voice mail . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Configuring presence profile . . . . . . . . . . . . . . . . . . . . . . 78

Configuring keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
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Configuring the display
This section explains how to set display properties.

Setting the display
You may find the display is too bright or too dark.

Display Description

Contrast level Setting the display contrast.

Backlight
(Mitel 6865 SIP only):

Setting the backlight:

• Off The backlight is always deactivated.

• Auto The backlight is switched on automatically when the 
phone is used and switched off automatically when the 
phone is in an idle state for a certain period of time.

Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Display and press the navigation key to the right.

Setting the contrast:
1. Scroll to Contrast level and press the navigation key to the right.
2. Set the desired contrast using the horizontal navigation key and confirm with 

the Select softkey.

Setting the backlight:
1. Scroll to Backlight and press the navigation key to the right.
2. Select the required setting and confirm with the navigation key to the right.
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Configuring the audio properties
This section explains how to set audio properties.

Adjusting the volume
You want to change the volume of the ring tone or the handset during a 
call.

Ring volume: You can adjust the volume in the idle state or when the ring 
tone sounds. Press and hold the volume down button to switch off the ring 
tone completely.

Handset volume: You need to set the volume of handset and loudspeaker 
separately. The new volume will remain saved even after the call is ended.

Setting the ringing properties
You want to change the way in which your phone rings.

Available settings:

Adjusting the volume (in idle state, during ringing phase/call):
Quieter: Press the  key.
Louder: Press the  key.

Ring tones Description

Ring tone

• Ring tone 1...15 Selection of available ring melodies.

• Silent If you do not want to be disturbed during a certain time, 
you can set your phone not to ring with Suppress ring 
tone.

Tone set Country-specific ring tone settings. This menu is set by 
your system administrator.
Mitel 6863 SIP / Mitel 6865 SIP 69
eud-1663/1.0 – R4.0 – 06.2015



 Personalizing your phone
Note: A list of alarm melodies is available for playback: Menu > Alarm melodies 
> Test.

Setting the audio properties
Using your phone, you can make and answer calls using the handset, 
headset or handsfree system. The audio settings allow the use of different 
combinations of these three operation modes in order to achieve maxi-
mum flexibility in phone operation. The following options are available for 
selection:

Setting the ring:
Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Tones and press the navigation key to the right.

1. Scroll to Tones and press the navigation key to the right.
2. Select the setting you want and confirm with the Set softkey.

Audio settings Description

Audio Mode1): Setting possibilities:

• Speaker The connection is made via headset. The LED on the 
loudspeaker key flashes slowly.

• Headset The connection is made via handsfree system. The LED 
on the loudspeaker key lights up. Press the handsfree 
key to switch to the headset.

• Speaker/Headset The connection is made via handsfree system. The LED 
on the loudspeaker key lights up. Press the handsfree 
key to switch to the headset.

• Headset/Speaker The connection is made via headset. The LED on the 
loudspeaker key lights up. Press the handsfree key to 
switch to handsfree mode.
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Note: To find out how to make phone calls with the headset, refer to "Using a 
headset (Mitel 6865 SIP only)", Seite 26.

Configuring general phone settings
This section explains other settings you can make on your phone.

Selecting the language
You wish to select a different user language for your display.

Headset Mic Vol Sets the volume of the headset microphone.

DHSG Activate/deactivate DHSG.
Phoning using a cordless headset based on the DHSG 
standard allows you to set up and to end calls from the 
headset. Ask your dealer which headsets are particularly 
well suited for this phone.
To avoid damages on the phone always disconnect the 
phone from the mains power first before you install a 
DHSG headset.

1) All setting possibilities for the headset only apply to the Mitel 6865 SIP.

Audio settings Description

Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Set Audio and press the navigation key to the right.

Setting the audio mode:
1. Scroll to Set Audio and press the navigation key to the right.
2. Select the setting you want and confirm with the Set softkey.

Setting the headset volume (Mitel 6865 SIP only):
1. Scroll to Headset Mic Vol and press the navigation key to the right.
2. Select the setting you want and confirm with the Set softkey.
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To change both the local user language and the user language of the 
MiVoice Office 400 communication system, configure the language set-
tings for your phone over the Self Service Portal. For more information 
about the Self Service Portal, please refer to "MiVoice Office 400 Self Ser-
vice Portal", Seite 8.

The language selection is limited to five languages. If the language you 
want is not available, then your system administrator can upload additional 
language packs. English is the standard language and is contained in 
every language pack.

Selecting the time and date
The settings for the time and date are made by your system administrator. 
The following chapter is thus intended for your system administrator or 
technician, who will then set the time and date for you.

As system administrator or technician, you can make global settings for 
the time and date for all Mitel SIP phones in the MiVoice Office 400 com-
munication system. If no NTP time server is entered in the communication 
system, then you can also make these settings over the phone. Available 
settings:

Setting Description

Time format 12-hour or 24-hour clock format.

Daylight savings List of available summer time formats.

Date format List of available global time zones.

Time zone List of available global time zones.

Time server 1-3 Setting menu for the IP address or domain name of the 
time server. If a valid time server is set, then the phone 
synchronises the displayed time with the specified con-
figuration server. The phone adopts the time from time 
server 1. If this is not configured or cannot be reached, 
then the phone queries first time server 2 and then 3.

Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Time/date and press the navigation key to the right.
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Using Live Dialpad (single-digit dialling)
Activates or deactivates the Live Dialpad. This local function is not sup-
ported by the MiVoice Office 400 communication system.

Using speed dial edit
Menu for configuration of the keypad speed dial. This local function is not 
supported by the MiVoice Office 400 communication system.

Changing the PIN
You want to change the PIN used to lock/unlock your phone and protect 
your phone settings (more information about locking/unlocking your phone 
can be found in chapter "Locking/Unlocking your phone").

The digit combination "0000" is set as default. You can select any 2 to 8-
digit combination for your new PIN. The PIN on your phone is changed 
using the Self Service Portal. For more information about the Self Service 
Portal, please refer to "MiVoice Office 400 Self Service Portal", Seite 8.

Notes: • The PIN that you have changed locally on your phone cannot be dis-
played or overwritten over the Self Service Portal.

• If you change your user PIN in the Self Service Portal, it will be valid for 
all your phones in the one number user concept (see "One number user 
concept", Seite 7).

Enter the display text for the idle state
You want to change the text displayed by your phone in the idle state.

The display text shown in the idle state on your phone is configured using 
the Self Service Portal. For more information about the Self Service Portal, 
please refer to "MiVoice Office 400 Self Service Portal", Seite 8.

Scroll to the setting you want and press the navigation key to the right.

Select the setting you want and confirm with the Set softkey.
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Local IP settings
The specific data for your phone, such as IP address or memory, is stored 
in the option key menu > or Menu > Information. The input of this data is 
password-protected; it can therefore only be carried out by your system 
administrator. You can however call up the data.

Restarting the phone
You want to restart your phone. You have to restart your phone after the 
following actions:

• Uploading a new language pack or updating a newly selected lan-
guage.

• Uploading new phone software.

• Confirming new settings.

Calling up the phone status:
Press the Option key.

Scroll to Phone status and press the navigation key to the right.
➔Settings are displayed.

Calling up the system menu:
Press the function key for Menu.

Scroll to Information and press the navigation key to the right.
➔Settings are displayed.

Press the Option key.

1. Scroll to Restart phone and press the navigation key to the right.
2. Answer the security question with Yes.
➔The phone is restarted.
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Protecting yourself against calls
The protection function helps to protect yourself against other users 
applying telephony features on you via menu guidance or using func-
tion codes.

Activating protection against call types
You want to protect yourself against certain types of call. You can protect 
yourself from the following types of call:

• Call waiting
• Intrusion

• Call forwarding
• Announcement
• Fast take

• Remote control

Protection for these call types is configured using the Self Service Portal. 
For more information about the Self Service Portal, please refer to 
"MiVoice Office 400 Self Service Portal", Seite 8.

Phone book management
This section includes important information on your phone books.

Selection
If your phone is connected to an MiVoice Office 400 communications sys-
tem, then the following phone books can be selected:

System phone book

The system phone book contains the contacts of the users on the MiVoice 
Office 400 communication system and your private contacts, to which only 
you have access. It is integrated into the MiVoice Office 400 communica-
tion system by your system administrator.

With the help of quickdial and dialling by name in the system phone book, 
you can search for and call both a contact in the MiVoice Office 400 com-
munication system and in your private phone book.
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Local phone book:

Aside from the system phone book, your phone also has a local phone 
book. This can be assigned to a function key.

The local phone book is not supported by the MiVoice Office 400 commu-
nication system. This implies that contacts saved in this local phone book 
are only available on your Mitel SIP phone. The search function in the sys-
tem phone book (quickdial and dialling by name) does not search in the 
local phone book.

Private contacts:

We recommend using the following products to manage your private con-
tacts:

• Self Service Portal (see chapter "MiVoice Office 400 Self Service Por-
tal", Seite 8).

• Mitel Mitel OfficeSuite

• External directories, such as Microsoft Exchange (provided your 
MiVoice Office 400 communication system is synchronised with exter-
nal directories).

Notes: Searching using the phone books is explained in more detail under "Dial-
ling from the phone book (directory lookup)", Seite 27.

Configuring voice mail
This section explains how to set your voice mail.

Managing personal voice mail greeting
In line with the system configuration, you have the option of recording up 
to 3 different greetings (e.g. for absences or holidays). Give each greeting 
a relevant name. Depending on the system configuration a caller may or 
may not be able to leave a message (for the symbols see mode).

If no personal greeting is activated or if none is available, the global greet-
ing is activated automatically, provided it has been recorded. For further 
information on voice mail refer to your system administrator or the User 
Guide Voice Mail Systems on the Mitel DocFinder.

The following options are available for further editing of your voice mail 
greetings:
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Operation of voice mail is available via the system menu, a function key 
(see chapter "Configuring keys", Seite 80), or the Self Service Portal (see 
chapter "MiVoice Office 400 Self Service Portal", Seite 8).

Menu Description

Record Record voice mail greeting.

Select Activating the voice mail greeting.

Edit Renaming the voice mail greeting.

Mode: Selecting the mode:

• Recording allowed Caller can leave a message.

• Recording not 
allowed

Caller cannot leave a message.

Play Play voice mail greeting

Press the function key for Menu.

Scroll to Voice Mail and press the Enter softkey.

Select any entry and press the Execute softkey.

Scroll to Settings and press the Enter softkey.

Renaming the voice mail greeting:
1. Select the greeting you want and press the Execute softkey.
2. Press the Edit > Enter softkey.
3. Enter the name and confirm with the Execute softkey.

Recording voice mail greeting:
1. Select the greeting you want and press the Execute softkey.
2. Press the Record > Enter softkey.
3. Pick up the handset and record your own personal greeting.
4. Stop the recording using the Done softkey.

Playing voice mail greeting:
1. Select the greeting you want and press the Execute softkey.
2. Press the Play > Enter softkey.
3. You can monitor your personal greeting text and re-record it if necessary.
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Configuring presence profile
Do you want to manage your incoming calls taking your current presence 
status into account (see chapter  "Organising absences from the desk", 
Seite 56).

You have a choice of 5 presence profiles for controlling your presence sta-
tus: Available, Absent, Meeting, Busy, Not available. Presence profiles 
contain action commands that are executed when the presence status is 
activated. This may be a call forwarding to a voice mail and/or a prede-
fined personal call routing.

For each of these presence profiles you can make the following settings:

Selecting the mode:
1. Select the greeting you want and press the Execute softkey.
2. Press the Mode > Enter softkey.
3. Select the mode you want and confirm with the Enter softkey.

Activating the voice mail greeting:
1. Select the greeting you want and press the Execute softkey.
2. Confirm with the Select > Enter softkey.

Menu Description

Description Type in the text to be displayed to other users as detailed 
information for your presence status (e.g.:  “Meeting until 
4 pm.”). You can also leave this input field blank.

Time/Date Type in the time and/or date of your absence: This infor-
mation is played to your caller, providing you selected 
the Absence information setting for call forwarding to 
voice mail. You can also leave this input field blank.

Personal call routing: Specify the phones on which a call is to be signalled (see 
"Activating personal call routing", Seite 45).

• Keep settings as is Calls are routed according to your settings.

• Routing ID <1...5> Your personal call routing number.

Call forwarding: Specify the phones on which a call is to be signalled (see 
"Activating personal call routing", Seite 45).

• Keep settings as is Calls are routed according to your settings.

• Forwarding off Any configured call forwarding operation is deleted.
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Operation of the presence settings is available via the system menu, a 
function key (see chapter "Configuring keys", Seite 80), or the Self Service 
Portal (see chapter "MiVoice Office 400 Self Service Portal", Seite 8).

Note: You can specify in theSelf Service Portal whether you 
want the same or a different forwarding destination for 
external and internal calls. The call number of the exter-
nal call forwarding destination is then always shown on 
your phone display unless the external forwarding desti-
nation is No forwarding.

• User A call is channelled to the defined forwarding destina-
tion.

• Voice Mail A call is forwarded to voice mail. The greeting to be 
played can be configured with voice mail greeting.

Voice mail greeting: Activate the greeting you want.

• Keep settings as is Your currently defined greeting is used.

• Absence informationYour caller is given an absence information (as well as 
time and date, if this has been configured as such in the 
presence profile). This setting is not available in the 
Available presence profile. More information can be 
found under "Absence information", Seite 57.

• Default greeting The global greeting is played back to your caller.

• Personal greeting • If you renamed your personal greeting, your greeting 
name is displayed here. Your caller obtains one of the 
personal greetings.

• The time and date are never played in the global 
greeting and personal greetings.

Menu Description

Press the function key for Menu.

Scroll to Presence and press the Run softkey.

Changing the presence profile:
1. Select the presence profile you want and press the Execute softkey.
2. Press the Modify > Enter softkey.
3. Select the setting you want and press the Enter softkey.
4. Make the changes and confirm with the Enter softkey.
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Configuring keys
This section explains how to assign call numbers, functions and 
busy lamp fields to a key.

Available keys
You can assign the configurable keys of your phone with a specific action 
type so you can trigger a particular action by simply pressing that key. The 
following choice is available:

Action type Designation Description

Call number Number key Configure a key with a call number and 
name

Function Function key Configure a key with a function in order to 
run or activate/deactivate a function.

Busy lamp field1)Team key2) Configure a key with your team partner's 
call numbers.

KT line Line key A line key has a call number which can be 
used for internal or external calls. In gen-
eral, multiple phones can be connected to 
this line. Your phone becomes a key tele-
phone as soon as your system administra-
tor has assigned the first KT line to a con-
figurable key. You can make the personal 
settings for the KT line in the Self Service 
Portal.
KT lines are only possible on function 
keys T1 to T20 (Mitel 6867 SIP) or T1 to 
T40 (Mitel 6869 SIP). For more informa-
tion on KT line keys, please refer to "Line 
keys on the key telephone (Mitel 6865 SIP 
only)", Seite 64.
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Configuring or deleting a key assignment
You want to configure a configurable key with a call number, function or 
busy lamp field, or to delete the key configuration.

Keys must be configured by your system administrator or by yourself in the 
Self Service Portal (see "MiVoice Office 400 Self Service Portal", Seite 8). 
An overview of the available functions can be found in the chapter "Over-
view of available functions", Seite 51.

Note: A key that you have configured locally on your phone cannot be displayed 
or overwritten over the Self Service Portal.

Operator Operator phone An operator phone has a line key with a 
call number on which both external and 
internal incoming calls can be connected. 
Your phone becomes an operator phone 
as soon as your system administrator has 
assigned the first line key on your phone. 
You can make the personal settings for 
the operator phone in the Self Service 
Portal.
Lines for operator phones are only possi-
ble on function keys T1 to T20 
(Mitel 6867 SIP) or T1 to T40 
(Mitel 6869 SIP). For more information on 
KT line keys, please refer to "Line keys on 
the key telephone (Mitel 6865 SIP only)", 
Seite 64.

Personal line Personal call key Personal line on key telephones and oper-
ator phones on which you can make per-
sonal calls. The personal line is created 
automatically as soon as your system 
administrator has assigned a key on your 
phone as a KT line or operator.

Note: Your phone can be either a key telephone or an operator 
phone.

1) Mitel 6865 SIP only

2) The audio features of a busy lamp field can be configured in the Self Service 
Portal (see "MiVoice Office 400 Self Service Portal", Seite 8).

Action type Designation Description
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Operating a key with key configuration
A key with a key configuration can be operated as follows:

Calling the call number of a number key:
Press the key for <Call number>.
➔The contact for this call number is called.

Activating/deactivating the function:
Press the function key for <Function>.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Calling the call number of a busy lamp field key:
Press the function key for <Busy lamp field>.
➔The call number of the busy lamp field key is called.
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Product and safety informa-
tion

The product and document information is available 
here. You will also find notes on safety, data protection 
and legal notes. Please read through this product and 
safety information carefully.

Safety information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Product information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
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Limited Warranty (Australia only)  . . . . . . . . . . . . . . . . . . 86
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Safety information
The safety information can be found in the chapter "Safety information", 
Seite 3.

Product information

Purpose and function
This product is part of the MiVoice Office 400 communication solution.

MiVoice Office 400 is an open, modular and comprehensive communica-
tion solution for the business sector with several communication servers of 
different output and expansion capacity, a comprehensive telephone port-
folio and a multitude of expansions. They include an application server for 
Unified Communications and multimedia services, an FMC (Fixed Mobile 
Conversion) controller for integrating mobile phones, an open interface for 
application developers and a multitude of expansion cards and modules.

The business communication solution with all its components was devel-
oped to cover in full the communication requirements of businesses and 
organisations, in a way that is both easy to use and maintenance-friendly. 
The individual products and components are coordinated and must not be 
used for other purposes or replaced by third-party products or components 
(unless it is to connect other approved networks, applications and tele-
phones to the interfaces certified specially for that purpose).

User information

Your product is supplied with a Quick User’s Guide, safety information and, 
where applicable, with other product-specific information. These and all 
other user documents are available for download from the Mitel DocFinder 

Document portal: www.mitel.com/docfinder.

© The information, graphics and layouts featured in the user information are 
subject to copyright and may not be duplicated, presented or processed without 
the written consent of Mitel Schweiz AG.
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as individual documents or as documentation set. It is your responsibility to 
keep up to date with the scope of functions, the proper use and the opera-
tion of your product.

• Make sure you have all the user documents required to operate your 
product efficiently and correctly.

• Make sure that the versions of the user documents comply with the soft-
ware level of the MiVoice Office 400 products used and that you have 
the latest editions.

• Always read the user documents first before you put your product into 
operation.

• Store the user information within easy reach and refer to it whenever 
uncertainties arise in connection with the use of the product.

• When handing over your product to others, make sure you enclose the 
relevant user information.

Trademarks
Mitel® is a registered trademark of Mitel Networks Corporation.

All other trademarks, product names and logos are trademarks or regis-
tered trademarks of their respective proprietors.

The designations used in this manual for software and hardware are regis-
tered trademarks and are thus subject to the relevant regulations.

Exclusion of liability
This exclusion of liability is not valid for Australia. For more information 
about exclusion of liability in Australia refer to chapter "Limited Warranty 
(Australia only)", Seite 86.

All parts and components of the MiVoice Office 400 communication solu-
tion are manufactured in accordance with ISO 9001 quality guidelines. The 
relevant user information has been compiled with the utmost care. The 
functions of the MiVoice Office 400 products have been tested and 
approved after comprehensive conformity tests. Nonetheless, errors can-
not be entirely excluded. The manufacturers shall not be liable for any 
direct or indirect damage that may be caused by incorrect handling, 
improper use, or any other faulty behaviour. Potential hazards are men-
tioned in the relevant places in the user information. Liability for loss of 
profit shall be excluded in any case.
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About Mitel
Mitel® (Nasdaq:MITL) (TSX:MNW)is a global leader in business communi-
cations that easily connect employees, partners and customers - any-
where, anytime and over any device, for the smallest business to the larg-
est enterprise. Mitel offers customers maximum choice with one of the 
industry’s broadest portfolios and the best path to the cloud. With more 
than US$1 billion in combined annual revenue, 60 million customers world-
wide, and #1 market share in Western Europe, Mitelis a clear market 
leader in business communications. For more information, go to 
www.mitel.com.

Data protection

Protection against listening in and recording
The MiVoice Office 400 communication solution comprises features which 
allow calls to be monitored and recorded without the call parties noticing. 
Please note that these features can only be used in compliance with 
national data protection provisions.

Limited Warranty (Australia only)
The following limity warranty agreement is valid for Australia only.

The benefits under the Mitel Limited Warranty below are in addition to 
other rights and remedies to which you may be entitled under a law in rela-
tion to the products.

In addition to all rights and remedies to which you may be entitled under 
the Competition and Consumer Act 2010 (Commonwealth) and any other 
relevant legislation, Mitel warrants this product against defects and mal-
functions in accordance with Mitel’s authorized, written functional specifi-
cation relating to such products during a one (1) year period from the date 
of original purchase ("Warranty Period"). If there is a defect or malfunction, 
Mitel shall, at its option, and as the exclusive remedy under this limited 
warranty, either repair or replace the product at no charge, if returned 
within the warranty period.
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Repair Notice
To the extent that the product contains user-generated data, you should be 
aware that repair of the goods may result in loss of the data. Goods pre-
sented for repair may be replaced by refurbished goods of the same type 
rather than being repaired. Refurbished parts may be used to repair the 
goods. If it is necessary to replace the product under this limited warranty, 
it may be replaced with a refurbished product of the same design and col-
our.

If it should become necessary to repair or replace a defective or malfunc-
tioning product under this warranty, the provisions of this warranty shall 
apply to the repaired or replaced product until the expiration of ninety (90) 
days from the date of pick up, or the date of shipment to you, of the 
repaired or replacement product, or until the end of the original warranty 
period, whichever is later. Proof of the original purchase date is to be pro-
vided with all products returned for warranty repairs.

Exclusions
Mitel does not warrant its products to be compatible with the equipment of 
any particular telephone company. This warranty does not extend to dam-
age to products resulting from improper installation or operation, alteration, 
accident, neglect, abuse, misuse, fire or natural causes such as storms or 
floods, after the product is in your possession. Mitel will not accept liability 
for any damages and/or long distance charges, which result from unau-
thorized and/or unlawful use.

To the extent permitted by law, Mitel shall not be liable for any incidental 
damages, including, but not limited to, loss, damage or expense directly or 
indirectly arising from your use of or inability to use this product, either 
separately or in combination with other equipment. This paragraph, how-
ever, is not intended to have the effect of excluding, restricting or modifying 
the application of all or any of the provisions of Part 5-4 of Schedule 2 to 
the Competition and Consumer Act 2010 (the ACL), the exercise of a right 
conferred by such a provision or any liability of Mitel in relation to a failure 
to comply with a guarantee that applies under Division 1 of Part 3-2 of the 
ACL to a supply of goods or services.

This express warranty sets forth the entire liability and obligations of Mitel 
with respect to breach of this express warranty and is in lieu of all other 
express or implied warranties other than those conferred by a law whose 
application cannot be excluded, restricted or modified. Our goods come 
with guarantees that cannot be excluded under the Australian Consumer 
Law. You are entitled to a replacement or refund for a major failure and for 
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compensation for any other reasonably foreseeable loss or damage. You 
are also entitled to have the goods repaired or replaced if the goods fail to 
be of acceptable quality and the failure does not amount to a major failure.

Warranty Repair Services
Procedure: Should the product fail during the warranty period and you 
wish to make a claim under this express warranty, please contact the Mitel 
authorized reseller who sold you this product (details as per the invoice) 
and present proof of purchase. You will be responsible for shipping 
charges, if any.

Limitation of liability for products not of a kind ordinarily acquired for per-
sonal, domestic or household use or consumption (e.g. goods/services 
ordinarily supplied for business-use).

Limitation of liability

1.1 To the extent permitted by law and subject to clause 1.2 below, the liability 
of Mitel to you for any non-compliance with a statutory guarantee or loss or 
damage arising out of or in connection with the supply of goods or services 
(whether for tort (including negligence), statute, custom, law or on any 
other basis) is limited to:

a) in the case of services:

i) the resupply of the services; or

ii) the payment of the cost of resupply; and

b) in the case of goods:

i) the replacement of the goods or the supply of equivalent goods; or

ii) the repair of the goods; or

iii) the payment of the cost of replacing the goods or of acquiring equiv-
alent goods; or

iv) the payment of the cost of having the goods repaired.

1.2 Clause 1.1 is not intended to have the effect of excluding, restricting or 
modifying:

a) the application of all or any of the provisions of Part 5-4 of Schedule 2 
to the Competition and Consumer Act 2010 (the ACL); or

b) the exercise of a right conferred by such a provision; or

c) any liability of Mitel in relation to a failure to comply with a guarantee 
that applies under Division 1 of Part 3-2 of the ACL to a supply of goods 
or services.
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After Warranty Service
Mitel offers ongoing repair and support for this product. If you are not oth-
erwise entitled to a remedy for a failure to comply with a guarantee that 
cannot be excluded under the Australian Consumer Law, this service pro-
vides repair or replacement of your Mitel product, at Mitel's option, for a 
fixed charge. You are responsible for all shipping charges. For further 
information and shipping instructions contact:

Manufacturer: Note:

Mitel South Pacific Pty Ltd ("Mitel")
Level 1, 219 Castlereagh Street
Sydney, NSW2000, Australia
Phone: +61 2 9023 9500

Repairs to this product may be made only 
by the manufacturer and its authorized 
agents, or by others who are legally 
authorized. Unauthorized repair will void 
this express warranty.
Mitel 6863 SIP / Mitel 6865 SIP 89
eud-1663/1.0 – R4.0 – 06.2015



Index
A
Absence information, setting  . . . . . . . . . 57

Accessories see: Safety information  . . . . . 3

Advanced search  . . . . . . . . . . . . . . . . . . 27

Alarm melodies . . . . . . . . . . . . . . . . . . . . 70

Alphanumeric keyboard  . . . . . . . . . . . . . 18

Ambient conditions see: Safety 

information  . . . . . . . . . . . . . . . . . . . . . . . . 3

Announcement:
– Announcement to group  . . . . . . . . . . . 39
– receiving  . . . . . . . . . . . . . . . . . . . . . . . 40
– starting  . . . . . . . . . . . . . . . . . . . . . . . . 39

Appointment call, acknowledging:
– Repeat appointment call . . . . . . . . . . . 48
– Single appointment call . . . . . . . . . . . . 48

Audio properties, setting . . . . . . . . . . . . . 70

B
Brokering  . . . . . . . . . . . . . . . . . . . . . . . . 35

Busy lamp field . . . . . . . . . . . . . . . . . . . . 62

C
Call Forwarding on No Reply  . . . . . . . . . 58

Call forwarding:
– always (CFU)  . . . . . . . . . . . . . . . . . . . 58
– if busy (CFB) . . . . . . . . . . . . . . . . . . . . 58
– on no reply (CNFR) . . . . . . . . . . . . . . . 58
– to voice mail  . . . . . . . . . . . . . . . . . . . . 58

Call list:
– calling a contact  . . . . . . . . . . . . . . . . . 60
– deleting an entry . . . . . . . . . . . . . . . . . 60
– detailed information . . . . . . . . . . . . . . . 60
– of answered calls  . . . . . . . . . . . . . . . . 28
– of dialled call numbers  . . . . . . . . . . . . 28
– of unanswered calls  . . . . . . . . . . . . . . 28

Call logging managementsee: 

OpenCount . . . . . . . . . . . . . . . . . . . . . . . .65

Call partners, holding see: Hold . . . . . . . . .34

Call routing profile  . . . . . . . . . . . . . . . . . .46

Call routing, activating  . . . . . . . . . . . . . . .45

Call transfer:
– with prior notice  . . . . . . . . . . . . . . . . . .37
– without prior notice . . . . . . . . . . . . . . . .37

Callback:
– answering . . . . . . . . . . . . . . . . . . . . . . .33
– requesting . . . . . . . . . . . . . . . . . . . . . . .32

Calls, forwarding see: Call forwarding . . . .58

Calls:
– answering . . . . . . . . . . . . . . . . . . . . . . .24
– answering for a team partner . . . . . . . .63
– ending . . . . . . . . . . . . . . . . . . . . . . . . . .24
– initiating  . . . . . . . . . . . . . . . . . . . . . . . .26
– making  . . . . . . . . . . . . . . . . . . . . . . . . .24
– private call with PIN  . . . . . . . . . . . . . . .31
– recording  . . . . . . . . . . . . . . . . . . . . . . .41
– rejecting  . . . . . . . . . . . . . . . . . . . . . . . .24
– take (pick up own call)  . . . . . . . . . . . . .39
– with another Mitel phone  . . . . . . . . . . .30

CLIR see: Hide number . . . . . . . . . . . . . . .33

Conference call, making  . . . . . . . . . . . . .35

Configurable key, using . . . . . . . . . . . . . .16

Connect see: Call transfer . . . . . . . . . . . . .37

Connections see: Safety information . . . . . .3
Cost control see: Safety information  . . . . . .3

D
Data protection . . . . . . . . . . . . . . . . . . . . .86

Date, setting . . . . . . . . . . . . . . . . . . . . . . .72

Deflect see: Call transfer . . . . . . . . . . . . . .37

DHSG standard audio features  . . . . . . . .70

Dial by name  . . . . . . . . . . . . . . . . . . . . . .27
90 Mitel 6863 SIP / Mitel 6865 SIP
eud-1663/1.0 – R4.0 – 06.2015



 

Dialling:
– by name . . . . . . . . . . . . . . . . . . . . . . . . 27
– from call list of answered calls . . . . . . . 28
– from call list of unanswered calls . . . . . 28
– from phone books  . . . . . . . . . . . . . . . . 27
– with configurable key . . . . . . . . . . . . . . 29
– with line key . . . . . . . . . . . . . . . . . . . . . 30
– with phone number  . . . . . . . . . . . . . . . 26
– with redial list . . . . . . . . . . . . . . . . . . . . 28

Dialpad see: Live Dialpad, using  . . . . . . . 73

Directories, managing see: Phone book . . 75

Directory Lookup . . . . . . . . . . . . . . . . . . . 27

Discreet ring, activating . . . . . . . . . . . . . . 42

Display symbols  . . . . . . . . . . . . . . . . . . . 14

Display text for idle state . . . . . . . . . . . . . 73

Disposal see: Safety information  . . . . . . . . 3

Do not disturb, activating:
– busy . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
– forward  . . . . . . . . . . . . . . . . . . . . . . . . 43

Document information . . . . . . . . . . . . . . . . 4

E
Enquiry call during a call . . . . . . . . . . . . . 34

Exclusion of liability . . . . . . . . . . . . . . . . . 85

F
Fast take . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Forwarding see: Call forwarding . . . . . . . . 58

Free seating  . . . . . . . . . . . . . . . . . . . . . . 49

Function  . . . . . . . . . . . . . . . . . . . . . . . . . 84

Function key configuration (default 

setting)  . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Function selection for configurable key . . 51

G
Group announcement see: 

Announcement  . . . . . . . . . . . . . . . . . . . . 39

H
Handset volume see: Volume . . . . . . . . . . 69

Handsfree . . . . . . . . . . . . . . . . . . . . . . . . 25

Headset:
– operation . . . . . . . . . . . . . . . . . . . . . . . 70
– using a  . . . . . . . . . . . . . . . . . . . . . . . . 26

Hide number:
– per call  . . . . . . . . . . . . . . . . . . . . . . . . 33
– permanent . . . . . . . . . . . . . . . . . . . . . . 33

Hold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Hotline  . . . . . . . . . . . . . . . . . . . . . . . . . . 50

I
Icons see Display symbols . . . . . . . . . . . . 14

Information see: IP settings  . . . . . . . . . . . 74

Intrusion  . . . . . . . . . . . . . . . . . . . . . . . . . 44

IP settings . . . . . . . . . . . . . . . . . . . . . . . . 74

K
Key telephone  . . . . . . . . . . . . . . . . . . . . 64

Key:
– assignment, configuring  . . . . . . . . . . . 81
– assignment, deleting . . . . . . . . . . . . . . 81
– designations  . . . . . . . . . . . . . . . . . . . . 10
– legend . . . . . . . . . . . . . . . . . . . . . . . . . 10
– selection  . . . . . . . . . . . . . . . . . . . . . . . 80

KT line:
– answering call on KT line key . . . . . . . 64
– Calling with KT line key . . . . . . . . . . . . 65
– key  . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

L
Labels:
– attaching . . . . . . . . . . . . . . . . . . . . . . . 22
– printing  . . . . . . . . . . . . . . . . . . . . . . . . 22

Language, selecting . . . . . . . . . . . . . . . . 71

LED  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Legend see Key legend . . . . . . . . . . . . . . 10

Limited Warranty (Australia only) . . . . . . 86

Line key  . . . . . . . . . . . . . . . . . . . . . . .30, 64

Listening see: Data protection  . . . . . . . . . 86

Live Dialpad, using . . . . . . . . . . . . . . . . . 73

Local IP settings see: IP settings . . . . . . . 74

Local phone book see: Phone book . . . . . 75
Mitel 6863 SIP / Mitel 6865 SIP 91
eud-1663/1.0 – R4.0 – 06.2015



 

Locking see: Phone lock  . . . . . . . . . . . . . 47

M
Maintenance see: Safety information . . . . . 3

Making calls see also: Calls, initiating . . . . 26

Making calls:
– in hands-free mode . . . . . . . . . . . . . . . 24
– in handsfree mode  . . . . . . . . . . . . . . . 25
– with headset  . . . . . . . . . . . . . . . . . . . . 26

Menu guidance see: Operation  . . . . . . . . 15

Message LED see: LED . . . . . . . . . . . . . . 19

Metal objects see: Safety information  . . . . 3

Microphone, muting  . . . . . . . . . . . . . . . . 25

Mitel M680  . . . . . . . . . . . . . . . . . . . . . . . 20

Mitel M680 expansion key module . . . . . 20

Mitel M685  . . . . . . . . . . . . . . . . . . . . . . . 21

Mitel M685 expansion key module . . . . . 21

MiVoice Office 400 Self Service Portal . . . 8

Mute  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

N
Navigation key, using . . . . . . . . . . . . . . . 15

O
One number user concept  . . . . . . . . . . . . 7

Open listening . . . . . . . . . . . . . . . . . . . . . 24

OpenCount . . . . . . . . . . . . . . . . . . . . . . . 65

Operating elements  . . . . . . . . . . . . . . . . 10

Operation  . . . . . . . . . . . . . . . . . . . . . . . . 15

P
Personal call routing see: Call routing, 

activating  . . . . . . . . . . . . . . . . . . . . . . . . 45

Phone book:
– external phone book . . . . . . . . . . . . . . 27
– local phone book . . . . . . . . . . . . . . . . . 75
– system phone book . . . . . . . . . . . . . . . 75

Phone lock  . . . . . . . . . . . . . . . . . . . . . . . 47

Phone status . . . . . . . . . . . . . . . . . . . . . . 74

Phone, activating  . . . . . . . . . . . . . . . . . . 30

PIN:
– changing . . . . . . . . . . . . . . . . . . . . . . . .73
– telephony, activating . . . . . . . . . . . . . . .65

Power supply see: Safety information . . . . .3

Presence profile:
– configuring  . . . . . . . . . . . . . . . . . . . . . .78
– selection . . . . . . . . . . . . . . . . . . . . . . . .56

Presence status, controlling . . . . . . . . . . .56

Product information  . . . . . . . . . . . . . . . . .84

Protection against call types  . . . . . . . . . .75

Q
Quickdial  . . . . . . . . . . . . . . . . . . . . . . . . .27

R
Recording see: Calls, recording . . . . . . . . .41

Recording see: Data protection . . . . . . . . .86

Redial list . . . . . . . . . . . . . . . . . . . . . . . . .28

Remote control . . . . . . . . . . . . . . . . . . . . .66

Restart phone  . . . . . . . . . . . . . . . . . . . . .74

Ring Alone, activating  . . . . . . . . . . . . . . .47

Ring tones  . . . . . . . . . . . . . . . . . . . . . . . .69

Ring volume see: Volume  . . . . . . . . . . . . .69

Ringing properties, setting . . . . . . . . . . . .69

S
Safety information  . . . . . . . . . . . . . . . . . . .3
Self Service Portal . . . . . . . . . . . . . . . . . . .8

Silent intrusion . . . . . . . . . . . . . . . . . . . . .44

Silent see: Ringing properties  . . . . . . . . . .69

Singel-digit dialling see: Live Dialpad, 

using  . . . . . . . . . . . . . . . . . . . . . . . . . . . .73

Softkey, using  . . . . . . . . . . . . . . . . . . . . .15

Speed dial edit, using . . . . . . . . . . . . . . . .73

Standard key configuration  . . . . . . . . . . .17

Switching between 2 call parties 

see: Brokering  . . . . . . . . . . . . . . . . . . . . . .35

Symbols see Display symbols . . . . . . . . . .14

System menu . . . . . . . . . . . . . . . . . . . . . .15
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System phone book see: Phone book  . . . 75

T
Take  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Team organisation see: Busy lamp field . . 62

Team partner:
– answering a call . . . . . . . . . . . . . . . . . . 63
– calling  . . . . . . . . . . . . . . . . . . . . . . . . . 63

Text:
– correcting . . . . . . . . . . . . . . . . . . . . . . . 18
– entering . . . . . . . . . . . . . . . . . . . . . . . . 18

Time, setting . . . . . . . . . . . . . . . . . . . . . . 72

Trademarks . . . . . . . . . . . . . . . . . . . . . . . 85

U
Unlocking see: Phone lock . . . . . . . . . . . . 47

User information  . . . . . . . . . . . . . . . . . . . 84

V
Voice mail see also: Voice message  . . . . . 61

Voice message:
– deflecting . . . . . . . . . . . . . . . . . . . . . . . 61
– deleting  . . . . . . . . . . . . . . . . . . . . . . . . 61
– detailed information . . . . . . . . . . . . . . . 61
– playing . . . . . . . . . . . . . . . . . . . . . . . . . 61

Voicemail:
– configuring . . . . . . . . . . . . . . . . . . . . . . 76
– greeting, managing  . . . . . . . . . . . . . . . 76

Volume  . . . . . . . . . . . . . . . . . . . . . . . . . . 69
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mitel.com
MITEL SCHWEIZ AG, SOLOTHURN

hereby declares that the MiVoice Office 400 products

• conform to the basic requirements and other relevant 
stipulations of Directive 1999/5/EC.

• are manufactured in conformity with RoHS according to 
2011/65/EU.

The product-specific declarations of conformity can be 
found on the Mitel document portal: 
www.mitel.com/docfinder.
© Copyright 2015 Mitel Networks Corporation. All Rights Reserved. The Mitel word and logo are trade-
marks of Mitel Networks Corporation.

Any reference to third party trademarks are for reference only and Mitel makes no representation of 
ownership of these marks.
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